
SAC Latest Release Info

Introduction
Welcome to SAC. This environment offers an exciting new vision from Bob Lentini. The 
interface is built around the idea of a complete Live Virtual Front-Of-House Console and 24 
Complete Virtual Monitor Consoles, all wrapped up in one program to offer an entirely new way 
of manipulating live audio in the virtual world.

Please take some time to explore the built-in HelpFile and also download the .pdf version of the 
manual, available at www.SoftwareAudioConsole.com. The navigation capabilities are powerful 
and complex and will require some getting used to. Reading, exploring and practicing inside the 
environment will greatly enhance your experience of the interface. The rewards gained for the 
time invested, will be great. Have fun!

Version History Follows:

>====<

Version 4.7
Enhancements
* Modified the main engine threads to make the engine more immune to slipped buffers. The 

new design makes it harder for Windows background processes to step on the main engine 
threads, therefore making the code more stable and less susceptable to buffer slippage.

* Added Soft-Clipping code into the Attenuator routines to prevent wrap-around clipping when 
recording in SAWStudio with the SACLink and adding gain to the channel input with the 
attenuator control.

Bug Fixes

>---<

Version 4.6a
Enhancements
* Expanded the max Output Channels for VST Plugins to 64 which should help with 

compatibility for plugins like Kontakt 6 and others.

Bug Fixes
* Adjusted code to compensate for VST Plugins that store very large amounts of data with 

their settingsin edls and other file saves. This code should now fix some plugins ability to 
save settings with session and other template files.



>---<

Version 4.6
Enhancements
* Changed code to drastically improve performance on Win 7, 8 and 10 for all shared 

SACLink operations between SAC and SAWStudio. CPU loads when using the SACLink are 
no longer heavily increased as data is passed between the two programs during recording and 
playback. This now matches, or even exceeds the SACLink performance that was achieved 
in XP.

* The helpfile now includes specific Win 10 tweaks.

Bug Fixes
* Fixed code that could overrun a few array variables when Max Count input and output 

devices are used.

>---<

Version 4.5
Enhancements

Bug Fixes
* Fixed F Monitor View display handling of Solo switches and Solo chase modes.

* Adjusted the Mixer Options menu to pay attention to Remote User Rights settings and 
disable certain combinations of options based on the remote User Rights.

* Fixed an issue with VST Plugin initialization that could cause certain VST Plugins to crash 
when patched.

>---<

Version 4.4
Enhancements
* Corrects HtmlHelp issues on some systems which will fail on the first attempt after a system 

reboot.

* Adds support for the newer large 3M Touch Screens. 



Bug Fixes
* Fixed touch positioning calculations onscreen when using more than two monitors.

* Fixed Edit Dialog box sizing to not cut off text on Win 7, 8 and 10.

>---<

Version 4.3
Enhancements
* Modified the small and large Touch Panel Keyboard zone to now run your favorite On-

Screen Keyboard application. Simply place a shortcut to your favorite On Screen Keyboard 
program in the SAC main folder and name it "osk". 

* Touch Panel Shift and Ctrl Flags are now cleared automatically when entering mixer labels.

* F-Key StartChan and HotChan properties now store and recall physical channels instead of 
virtual channels. This eliminates issues of channel re-ordering affecting the stored F-Key 
channel information and maintains the recall back to the original channel no matter how the 
mixer is re-ordered after the F-Keys are created. Any previous F-Keys using those options 
should be re-created and saved after installing this update.

* Added code to keep Helpfile ontop and keep from loading multiple instances.

Bug Fixes
* Fixed code to allow the MonF Mixer view to properly display Mute Thru Latches from a 

scene recall.

* Fixed code that could cause SAC to crash under certain SACLink conditions when the link 
was disabled and record was initiated in SAWStudio.

>---<

Version 4.2
Enhancements
* Adjusted the Touch Mixer View section popups to follow the touch position and respect the 

dual monitor configuration option setting to eliminate splitting the section view across screen 
boundaries. Both monitors need to be set to the same resolution for proper operation.

* Added the use of a Right-Mouse-Click or Right-Touch-Gesture to close any of the Touch 



Mixer View Section popups. Possibly easier when using touch than navigating to the Close 
Button.

* Enhanced the 3M Muilttouch Flick gesture to ignore the first touch if a flick is detected. The 
Right Click gesture has also been enhanced to recognize the actual click position as the first 
finger down. This allows you to target controls and screen zones with this gesture as easily as 
a single touch function.

* Adjusted the popup Exploded Mixer view to follow the mouse position and respect a vertical 
dual monitor configuration option setting and size itself to fit on only one monitor. Both 
monitors need to be set to the same resolution for proper operation.

* Modified code to remove meter display flashing and smooth out meter display resets during 
hot chan changes and improve display update performance.

* Added three new MCU Pro midi templates that eliminate the meters for faster and more 
stable performance.

Bug Fixes
* Fixed code that could cause latch data corruption when adjusting input source values under 

certain conditions.

* Fixed code to properly clear Touch Mixer meters when the engine is stopped under all 
conditions.

* Adjusted code to keep host TCP/IP master mode active when the last remotes are shutdown 
or disconnected. Also fixed possible interactions between the regular remote network 
protocol and the IOIH network protocol.

>---<

Version 4.1
Enhancements
* All window views are now "Border Padding" aware for better Win 7, 8 and 10 compatibility.

* Modified code to remove certain Windows display function calls from the engine loop that 
were video driver dependent and replace them with newly written code for increased 
performance and stability and less dependency on differences within video graphics drivers.

Bug Fixes
* Fixed code to correct for Taskbar on left or right side.



* Fixed Group Latch Mute switches to properly chase the Output Group Latch Chan Mute. 
This was broken in the 4.0 update.

* Fixed code to properly "Open the Last AutoSave Session" in all cases. It could fail under 
certain conditions previously.

* Fixed code to properly update the Mointor Full mixer view when a chan label color is altered 
from another mixer view.

* Fixed code to properly clear all monitor Mixer peaks when selecting that option from the 
Monitor Full mixer view

>---<

Version 4.0c
Enhancements
* Includes new IOIH Block Commands.

Bug Fixes
* Fixed code to properly save the IOIH and the MonF Mixer views in the F-Key defaults if 

they are part of the starting F-Key display.

* Fixed code to properly refresh the IOIH display between host and remotes when controls are 
adjusted.

* Fixed code to properly lockout Midi Controllers on remotes with No Access rights.

* Fixed code that could cause a crash when recalling scenes with auto fade times and CPU 
Blocking is active.

* Fixed code changes that affected BCF2000 and some other midi controller templates. This 
affected faders in group and latch mode which caused some faders not to track properly.

>---<

Version 4.0b
Enhancements
*

Bug Fixes



* Fixed midi control pans to react to group selection.

* Fixed Mackie MCUPro midi template transport lites to react correctly to the Stop, Play and 
REC modes under all combinations of play/rec activity with SAWStudio ver 5.6 and higher.

* Modified code to speed up MCUPro templates and fix metering issues that caused display 
flashing and bogdown issues with the newer units.

>---<

Version 4.0a
Enhancements
*

Bug Fixes
* Fixed Monitor F View popup faders.

* Fixed the extra engine loading that caused slipped buffers on some systems.

* Fixed CPU Blocking option that could cause lockups on some systems.

>---<

Version 4.0
Enhancements
* Windows 8 MultiTouch functions have been added to the code so any Windows 8 

compatible multitouch screen may be used with the multitouch functions when running 
Windows 8. I recommend you set the Touchscreen mode in the Mixer Menu to avoid faders 
snapping to your finger position. This option must be activated in the Options Menu in the 
Touch Devices Option.

Some useful gestures built into the SAC multitouch function support to learn and practice 
are:

Right-Click… done by tapping two fingers held very close together in a short single tap 
movement. The first finger down is the actual right-click screen point, so you can use this as 
the actual tap position as if you right-clicked with a mouse pointer at that specific screen 
position. There is only a single tap, but both fingers must hit the screen at very close to the 
same time.

Right-Hold… done by creating the right-click two finger gesture, but keeping the fingers in 
contact with the screen… the first finger down is the important touch position. This can then 
be used for vertical scrolling the Zoom Mixer window, by sliding the finger up or down in 



the same manner as when using the mouse. Only the first finger needs be held on the screen 
once the two finger right-click gesture is recognized.

Left-Flick… done by a single finger touch and a smooth quick flick motion to the left with 
the finger dragging on the screen. This can be used in the mixer views to page flip the current 
mixer to lower chan numbers. For instance… if 8 Z-Mixer chans are visible and the start 
chan is currently chan 9, this gesture would flip the view to start on chan 1.

Right-Flick… done by a single finger touch and a smooth quick flick motion to the right with 
the finger dragging on the screen. This can be used in the mixer views to page flip the current 
mixer to higher chan numbers. For instance… if 8 Z-Mixer chans are visible and the start 
chan is currently chan 1, this gesture would flip the view to start on chan 9.

* A new View has been added to the View Menu called Touch Mixer. This new mixer view and 
its associated section views have been designed to be touch freindly. They are larger in size 
with larger switches and controls that are spaced apart so it is easier to operate with your 
finger. The Touch Mixer view is saved as part of the F-Key Workspaces and can therefore be 
displayed by itself or in combination with all other workspace views. A blend of mixer views 
can be a very handy way to work. The Mixer View contains links at the top to specific 
section views for Input/Att, EQ, Dyn, FX, Aux and Assign/XY Pan, to give easy access to all 
controls of the FOH and Monitor mixers. See the helpfile or pdf manual for details.

* A new option has been added to the Mixer Menu called Touch Screen Mode - Lrg Titlebars. 
This option works exactly like the original Touch Screen mode, stopping the cursor from 
snapping to the mouse position, but also enlarges the size of the titlebars to be more touch 
friendly. This allows you to easily access the titlebar areas and close buttons with your 
finger. This mode saves with the preferences file. If you turn this mode on make sure to 
adjust your F-Key window views if needed, to compensate for the larger titlebar area. Then 
resave your F-Key defaults.

* Two more options have been added to the View Menu called Touch Panel Lrg and Touch 
Panel Lrg Visible As Default. These new options work like the original Touch Panel view but 
this view is larger to be more touch friendly. Now tablets can be comfortably used as remotes 
with just finger touch. The combination of the touch enhancements all combined can make 
for a very effective tablet style remote experience.

* Both Touch Panels have been enhanced with the addition of a new option labeled R Btn. This 
option makes Right-Click functions very easy to obtain with a single finger operation. Just 
click the R Btn option to create its flashing light, and then the next touch operation will 
become a Right-Click instead of a Left-Click. For most operations, the R Btn will then be 
disengaged until activated again. The Windows Taskbar popup option has been removed 
from the Touch Panels to make room for the R Btn function.

* The In and Out Device Menu Lists now display in columns to be more touch friendly on 
smaller tablets.



* The mixer views have been enhanced to expand the fader increment/decrement area across 
the meter display. The meter-clear popup menu is now available by Right-Clicking on the 
meter display.

* The Solo Bus mode has been enhanced to now include separate FOH and MON Master Bus 
Level settings as well as separate FOH and MON Offset Chan settings. The level processing 
has also been moved to be post any Solo FX Patches so that level displaying plugins (such as 
the Frequency Analyzer) are not affected by the bus level adjustments. The two new options 
added to the Mixer Menu Solo Mode option are called MON Solo Bus Level and Clear MON 
Solo Bus Master Offset Chan.

* New controls have been added to the system in a new view called the IOIH (I/O Interface 
Hardware) Control View to control a new 32 chan I/O Interface Mic Pre and Digital 
Converter hardware box created by an Italian company called Montarbo in direct association 
with myself. These controls consist of remote Mic Gain and Line Gain levels, and Mic/Line, 
Pad and 48V Phantom switches. These controls interact with the hardware circuitry directly 
from SAC Host or Remote systems over an ethernet connection and a new custom IOIH 
Control Ethernet protocol. They may also be used to control other hardware interface boxes 
in the future. This view displays all hardware interface channels and can chase cross-patched 
input chan devices and virtual mixer channels, to help link which hardware interface chan is 
controlling which SAC mixer chan. Jumping to the I/A section of one of the other mixer 
views by either clicking the F-Mixer I/A colored zone or by using the I key will cause the 
IOIH Control View to jump to the assigned hardware input (if one is assigned) for easy 
adjusting of cross-patched inputs and mixer channels. I still recommend patching on a 1 to 1 
basis however, hardware device 01 to SAC mixer chan 01, hardware device 02 to SAC mixer 
chan 02... etc. to keep things much simpler to relate to. These settings are tied to the I/A 
Scene Property switch and can be recalled with scenes if that switch is active. This adds great 
functionality to control complex band changes in a festival type situation which might 
include mic gain changes as well as other input hardware adjustments. The IOIH view is 
saved in the F-Key Workspaces and can therefore easily be blended with other views within 
different F-Key setups.

* Modified code to extend VST Plugin compatibility to the 2.4 version changes which should 
help with newer plugin compatibility issues. Not all new options are yet supported but this 
should allow many newer plugins to be used that otherwise would not load.

* The Input/Output Device count has been expanded to handle 60 stereo devices or 120 
channels in and 120 channels out. This can be facilitated with some Madi and Dante 
soundcard products that can handle large channel counts in one or two motherboard slots. 

* The Input Chan count of the system has been expanded to 120 channels as well. All older 
session and mix template files as well as scenes will automatically convert as they are 
opened. The extra channels past chan 72 will display at the end of the mixer views after the 
24 output channels. You can select them all and [Shift-Click] on any mixer chan number 
zone to snap them back in the proper order if desired. Be aware that older sessions, mix 
templates, scenes and system preferences will automatically adjust to the new expanded 



channel count structure, but anything saved on this version is not backward compatible to the 
earlier versions. Keep a backup copy of anything you feel you may need to use again on an 
earlier version. It is recommended that you re-save your preferences and mix sessions after 
first opening them in this version.

* Enhanced the SACLink code to handle 120 input chans for record through the SACLink with 
SAWStudio version 5.5 and higher.

* There is a new option on the Scene Properties Screen called Link FOH Partial Chans To All 
Mixers. This option makes it easy to create scenes that operate on a group of channels across 
all mixers. Now you no longer have to select all channels on each mixer separately for scenes 
that you want to operate across multiple mixers... simply select the channels on the FOH 
mixer and turn ON this new option... the partial listbox will display the list of channels and 
will display that they are selected for All Mixers.

* The mixer views now display the status of the Mute Thru Monitors Latch. A thin green line 
is displayed under the Mute switches which are latched thru to give a visible indication of 
which mutes will operate thru to the monitor mixers when clicked.

* Added a new Mixer View called Monitor F Mixer View. This exciting new view allows you 
to see all 24 monitor mixer settings for any one mixer chan. For instance, you can select the 
kick chan and see kick levels for all 24 monitor mixers at the same time. The view displays 
the same channel on up to 24 Full mixer modules at the same time. The view can be sized 
down and then the typical scrolling features apply for scrolling thru the different modules, 
which now represent mixers instead of channels. The current active channel and label is 
displayed at the top of the view. You can right-click anywhere within the view area to 
display a popup jump menu to change this active channel. The channel order displayed in the 
jump menu is dependent on the chan order for the currently selected mixer module you 
clicked on, which is highlighted exactly like the hotchan display in the Full mixer view. You 
can also move the mouse over the active channel area at the top of the view and use the 
wheel mouse to scroll thru the channels, again the order of which is dependent on the 
selected mixer module. While scrolling thru the different mixer modules in the display, if you 
hold the Alt-Key down, all mixer views will change to the currently selected mixer, 
displaying the actual mix itself. You may also set this option to always be active (no need for 
the Alt-Key) with a navigation link in the Mixer/Navigation Links menu. When scrolling thru 
hot channels in the other mixer views, the current active channel of the Monitor F view will 
chase. You can lock the view and stop the chan chase by right-clicking the close button in the 
upper right corner. When the lock is displayed, the current active channel will remain fixed 
until you change it directly in the view itself. You may also double-click any of the mixer 
modules and the Exploded View mixer will popup linked to the selected mixer module and 
the current active chan. From there you can change any of the control settings on the entire 
chan strip. This view can be an extremely powerful way to adjust and see what is happening 
with all 24 monitor mixers, but it can be confusing at first, because you have to get used to 
looking at mixer modules side by side instead of channel modules. This view saves with the 
F-Key workspaces.



* A new option has been added to the Mixer Menu Navigation Links option. It is called Link 
Monitor F Mixer View To Cur Mixer. This option forces the link between the Monitor F 
Mixer and all other mixer views to always chase and display the Hot Module selection in the 
Monitor F Mixer. This eliminates the need to press the [Alt-Key] to operate this feature.

* Added SACLink Output Record Bus functionality. Each of the SAC Master Outs and Aux 
Master Outs on all mixers can now be assigned to one of 8 Record Buses as well as Device 
Outs. This allows you to direct outputs for record as well as inputs. SAWStudio 5.5 adds the 
SACLink Record Bus functionality to the record meter input assignment menu. These 
assignments must be made manually. They will not automatically export to SAWStudio with 
the Import SAC Mix Data function.

* Modified the Midi Ctrl section to now handle 3 midi controller ports. This allows you to use 
control surface extenders with the Mackie and Icon Qcon controllers. There are new 
templates included that will now control 16 chans and 24 chans of the Mackie protocol, 
which includes full mixer processing controls (I/O, Eq, Auxes and Dynamics). The 16 chan 
template uses one Mackie Extender on the left and one Mackie Control Master on the right. 
The 24 chan template uses two extenders on the left and one master on the right. The Icon 
Qcon controllers work the same way with their own set of templates. New features have been 
added to the templates to include mixer switching and hooking the transport play/rec 
functions thru to the SACLink over to SAWStudio. Live meter displays on the Mackie (from 
host or remote) are also included... see the helpfile or manual for details.

* A new group of menu items has been added to the {Right-Click} Current Mixer popup menu. 
Copy Faders/Pans To, Copy Src-Ins To, Copy Eq To, Copy Dynamics To, and Copy Chan 
Order To. These options offer another approach to sharing data between mixers. These 
options also allow you to copy data from the current mixer to All Mixers or All Mon Mixers 
in one operation.

* A new option has been added to the Options menu called Force CPU Blocking. This option 
is designed to help reduce or eliminate slipped buffer problems on Windows 7 and 8. It can 
be used on a troubled XP system as well, but is mainly designed for Windows 8. Win 8 has 
changed the main thread scheduling system to attempt to even out cpu scheduling time across 
all cpus and all thread priorities. This allows other background processes to step on the main 
engine loop which requires as close to realtime priority as can be gotten inside an already 
non-realtime OS. When other cpu cores run code that accesses memory, all priorities are 
ignored and the main engine thread can be interrupted, causing it not to finish processing the 
audio buffers for all mixers within its designated looptime when under heavy loads. This 
results in missed data buffers causing audio glitches and distortion. The CPU Blocking code 
attempts to block the other cpu cores (up to 4 cores) from accessing memory during the 
realtime portion of the engine loop threads by forcing them into tight internal loops which 
only operate within the cpu registers themselves. This can have a significant effect in keeping 
the main engine threads from being interrupted as often, thereby allowing the audio 
processing to complete in time, and eliminate slipped buffers. Each system will react 
differently to these performance options. Test them individually and in combination to find 
what works best for your setup. This option saves with the preferences. If your system has 



more than 4 cores, it may be to your advantage to shut some down, in the motherboard bios, 
to use only 4 cores.

* Modified The Full Mixer Return Chan graphic to expand the Label Area for normal Return 
Labels and to accommodate the new Monitor F Mixer View.

* Completely re-formatted and re-compiled the helpfile into the newer html help .chm format. 
This allows for better searching and indexing as well as allows the helpfile to open correctly 
in Win 7 and 8.

* Modified the Channel Jump Menu List to fit better on smaller tablets.

* Added a new option to the Options menu / Touch Device Setup option called Touch Flick 
Reverse. When this option is activated, the directions of the flick gestures will work in 
reverse to the original description. This option saves with the preferences.

Bug Fixes
* Fixed code to correct wrap-around effect when using touch on the popup faders and pushing 

past fader limits in Windows 8.

* Fixed code to correct for low level solo volume wrap-around when using a master solo offset 
fader and also having the master solo level set to a minus value.

* Fixed some graphic label element alignments across the different module types on the default 
shade.

>---<

Version 3.1
Enhancements
* Added a Midi BankChange Filter option in the Midi-Ctrl-In Filter option of the Smpte/Midi 

menu. This allows pre-processing of Midi Bank Change commands to be turned off allowing 
the use of that type of CC message in midi templates.

* Added midi controller processing for sysex commands to expand the capabilities of 
controller template functions.

* Two new midi controller templates for programming your own controller have been added. 
These are Custom templates that handle all 102 chans of faders, mutes and solos using Midi 
CC commands on different midi chans. The HiRes version uses NRPN commands to get hi-
res data for the level controls. You can easily program controllers like the Behringer BCR 
and BCF devices to make use of these templates.

* The HelpFile and PDF Manual now include the tweaks guides for Win XP, 7 and 8.



Bug Fixes
* Fixed code that allows modal message dialog boxes to respond correctly to pen and touch 

commands in Windows 8.

* Fixed code to allow re-initialization of a broken SACLink due to a crash in SAWStudio that 
was previously linked. Now, after restarting SAWStudio and attempting to re-link, SAC will 
reset the current broken link and re-link without having to shutdown SAC and the engine.

* Fixed code to thin data sent to hardware controllers during scene fades. This helps slower 
controllers from being overloaded with too much data being sent too fast and forces the last 
proper value at the end of the fade time.

* Fixed code to trap group latches from accidently extending over to mouse controlled faders 
while a midi controller group latch fader is being grabbed.

* Fixed code to stop Zoom Mixer lockout when using the Jump to I, R, and O functions and 
the Zoom Mixer is set to not chase the Hot Channel in the Navigation Links.

* Adjusted code to help window views draw correctly under different conditions when 
switching between apps using various methods. This should help keep views from 
disappearing off the screen and ontop windows correctly ordered.

* Fixed code in the midi controller 14 bit resolution conversion routines which result in much 
more accuracy and smoothness of hi resolution fader controllers like the Behringer BCF and 
Mackie MCU controllers. All Hi-Res templates have been adjusted. Make sure to test and 
adjust any custom templates you may have created.

Eq Plugin Version 3.3
* Fixed code that traps max/min crashes when adjusting controls in Win 8 with a pen or touch. 

Forces you to be close to the knob when grabbing a control with a pen or touch so the value 
does not jump far to the current cursor position.

Echo Plugin Version 3.3
* Fixed code that traps max/min crashes when adjusting controls in Win 8 with a pen or touch. 

Forces you to be close to the knob when grabbing a control with a pen or touch so the value 
does not jump far to the current cursor position.

>---<

Version 3.0
Enhancements
* A new option has been added to the Options Menu Touch Device Setup option called 

Activate 3M MicroTouch Protocol. This option allows you to toggle the 3M MicroTouch 
protocol On and Off. If you have a 3M MicroTouch multitouch monitor connected to the 



system, this option must be activated to use the multitouch functions. This option defaults to 
Off, so it must be toggled On the first time and then saved in the default preferences.

* The Color Setup window has been activated for remotes to allow access to changing the Hot 
Chan Color. All other color choices can be set when the remote is not connected, but will 
grab their color settings from the host session when connected.

* Modified the Mackie Control Midi Template to extend the Attenuator control to +20db.

* The Scene Properties dialog now follows the current cursor position after answering the 
partial update message prompt regardless of where you activate it from. This keeps things 
more organized if you have the message dialog options set for a specific screen position on a 
dual or single large display.

* Modified code to ignore the chan solo switches when storing and recalling chan template 
data. This leaves the current solo mode, including an active output chase mode unchnaged 
after the chan recall.

Bug Fixes
* Fixed code that corrects the FBCenter XYPan adjustment for channels greater than 1. This 

previously only worked correctly on channel 1.

* Fixed code that could cause the solo buses to drift and delay after many hundreds of solo 
presses on certain system configurations.

* Fixed code to properly display disabled channels when first opening a session or mix 
template file.

* Fixed code to properly lockout keyboard and mouse control on a remote connected with NO 
ACCESS rights, and properly restore mouse and keyboard control when the remote is 
disconnected.

* Fixed code to display proper FOH or MON solo patch for DX and VST plugins at the top of 
the plugin display.

* Fixed code to properly have label and label color in scenes follow Scene Properties Mixer 
selection options. Only active channels and active mixers will now respond to label and label 
color changes in scenes.

* Modified code to correct various issues with mixer navigation link disables and window 
locks. Also separated certain midi controller functions from the onscreen active window.

>---<



Version 2.9
Enhancements
* Added a separator in the popup Chan Store/Recall menu between the Set Chan Label Color 

option and the Clear Current Chan option and a prompt to help eliminate accidental chan 
clearing.

Bug Fixes
* Fixed code to properly update the Touch Panel and DirX and VST window views after a 

shade change.

* Fixed code to allow Midi Control Templates that include a Master Fader to properly follow 
re-ordered Out channels and stay locked to Out Chan 1.

* Fixed code to stop possible crashes when patching native plugins from the host while other 
plugins with remote meter capabilities are displaying on any remote. Note this fix requires 
updating the Levelizer, Frequency Analyzer and Signal Switch plugins also, if these are 
installed.

* The XY Pan popup fader activation for the Lft/Rgt zone now correctly controls the Lft/Rgt 
movement.

* The Fkey Properties dialog now correctly retains its topmost status when switching to 
another program and returning while the dialog is active.

* Fixed code to properly update FX Patches windows after a chan reorder operation.

>---<

Version 2.8
Enhancements
* Modified the SACLink code to recognize the extended track count and recording options in 

SAWStudio 5.0.

* Modified code to add the MotorMix 24 chan midi control template capability.

* Added the Mackie Control Single Extender midi control template.

* Modified code to use the Ctrl-Break key combination (instead of the Break key alone) for the 
Forced Engine Shutdown function in the event of a hung audio driver condition.

* Added a new menu item to the Mixer Menu called Disable Default Value Snap-To. This 



option, when active, disables the [Left-Right-Click] or [Ctrl-Left-Click] snap-to default 
values for all controls.

* Output Sub Grp Latches now display the src meter tap of the group mix regardless of the 
master meter tap setting. This now allows the out group fader to be offset to any reference 
position (alt-adjust) without disturbing the meter from reading the actual level of the group 
mix. When selected as an actual physical group fader, everything responds according to 
normal settings.

* Added code to support changing mixers with the keyboard number keys in the three Fx patch 
windows.

* Modified code so that the SACLink Recall Scene By Name function recalls the scene without 
changing the scene selection in the scene view window. It will also ignore the Auto-Advance 
option.

* Modified the VST Options popup menu to display the plugin reported latency at the bottom 
of the menu. The option is grayed out and is used for informational purpose only. If this 
value is not zero, the plugin will be internally bypassed by the SAC engine. Some plugins 
may report zero or some latency value, but pass blank buffers of the correct size until 
generating real data… these plugins will function in SAC, but could cause phasing and 
latency issues because the real data is late.

* Eliminated the unused Edit Menu option from the main menu.

* Mute Thru Latches have been modified to behave as set even when part of groups or group 
latches. No matter how a mute switch gets activated (directly or thru group or group latches), 
the Mute Thru setting will behave correctly as set for that chan. You should test previous 
sessions and scenes that use Mute-Thru-Latches to make sure they are behaving as expected. 
In some cases you may have to modify the settings to achieve the same results as before.

Bug Fixes
* Fixed code to allow Midi Controllers to properly handle Latch and Rvs Latch groups.

* Fixed code to properly save and restore DirX and VST Plugin bypass switch setting with mix 
sessions and templates.

* Fixed code to stop Output Sub Grp Latches from adding group signal into the solo bus when 
the Out Grp chan is soloed. Now only the grouped input chans properly mix into the solo 
bus.

* Grouped chans now correctly clear previously active group solos when the group solo is 
toggled off. The active solo lite is also correctly disengaged.

* Fixed code to remove Task Manager CPU spike when checking for slipped buffers.



* Fixed code to trap for false value jumps on popup fader activation by accident when mouse-
click release is held long enough to release just as the popup fader is beginning to display.

* Fixed code to trap for possible divide by zero errors in the fader display scaling routines.

* The Shift-Left-Click on the Live Lite to re-sysnc the audio engine has been fixed to work 
correctly from remotes.

* Fixed code to allow main menu selection using one press of the Alt-Key and then the menu 
option key. This now also allows a keyboard switch to SAWStudio thru the SACLink with a 
press of the Alt-Key and then the L-Key.

* Fixed code to properly pass keyboard commands back to the currently active window while a 
timed message is displayed onscreen.

* Fixed code to trap for crash when a midi controller and mouse are adjusting the same fader at 
the same time.

* Fixed code to properly ignore any remote default mix template when clearing the session on 
a connected remote. This helps eliminate corruption caused by the blending of the default 
mix template data and the host data.

>---<

Version 2.7
Enhancements
* Added the use of the NumPad for changing mixers. You must make sure the NumLock mode 

is active and you must still use the two number keystrokes to designate a mixer.

* Enhanced the Mixer Popup Jump menu to draw separator lines wherever chan color changes 
occur as well as where chan types change.

* Enhanced the power of Latch groups in the popup Group Menu Options (Right-Click any 
mixer titlebar). Now you may create a Reverse (RVS) Latch group by Alt-Clicking (instead 
of Shift-Clicking) one of the 32 Latch Group entries while channels have been actively 
selected. A RVS Latch group works in reverse of a standard Latch group. The group of 
selected channels will operate as independent when making any normal adjustment, but will 
be latched together whenever any one of the channels is adjusted while pressing the Alt-Key. 
The RVS Latched channels do not have to be actively selected (once created) to operate all 
together in latched mode. This can be very handy for creating mute groups. The group will 
remain individual during normal mixing adjustments, but clicking a mute switch while 
pressing the Alt-Key will instantly mute the group.

* Enhanced the Scene Properties window exit with an alternate close to allow you to keep 
partial chan selections onscreen. When you close the Scene Properties window, if you press 



the Ctrl-Key when clicking OK or Cancel, the selected partial chans will not be cleared 
(same as selecting multiple temp groups)… making it easy to create more scenes for the 
same partial chans back to back. You can then clear the selections afterward by Right-
Clicking in the mixer chan selection zone at the top of any mixer view.

* Enhanced the Scene Properties window open function with a prompt to update the chan 
partial data with the new current selections. If you answer NO, the current chan partial data 
will be left alone and selected upon opening the window. If you answer YES, the current 
chan selections will overwrite the existing data. You can still Cancel the update by clicking 
the Cancel button when closing the window.

* Enhanced the Chan Selected cursor to display a + sign within it to show that chans are 
selected on multiple mixers at the same time.

* The session modify flag is now set when changing label colors.

Bug Fixes
* Modified code to help determine a lost remote connection immediately and trap the host 

from attempting to send data to it within a few seconds to protect the host from GUI 
lockdown when a remote network connection fails for some reason. The host will eventually 
break the bad connection and free the remote socket.

* Modified code to block F-Key and Mixer changes when any active fader adjustment mode or 
mixer scroll mode is active. This includes the use of popup faders. You must finish the active 
adjustment by first releasing the mouse button that is holding the mode active.

* Modified code to trap for and clear active control adjustment modes whenever the mouse 
button is released, including mixer scrolls and popup faders which somehow incorrectly 
allow the mouse outside the active zone area.

* Modified code to maintain perfect knob control tracking data when mouse is moved 
extremely fast and hits max or min values.

* Timed message displays no longer lockout the GUI control.

* When a Popup Fader, Fader Taper or a Plus-Minus control is active, multi-touch operations 
are trapped. These controls are single touch only. You must release these operations first 
before being able to operate multiple regular faders or switches on a supported multi-touch 
monitor surface.

* The Exploded Mixer View is now multi-touch aware and other faders may be simultaneously 
adjusted with a supported multi-touch monitor surface.

* Fixed code to keep the Scene Properties Window active when opening it by Right-Clicking a 
scene in the Scene Window.



* Fixed code to properly handle multi-touch groups and latches without breaking the group 
bond with more than 1 simultaneous fader grab.

* Fixed code to stop remote PER-MON solos from interfering with the FOH and MON Aux 
Return Chans.

* Fixed code to trap for Aux Return input device assignments that do not exist in the system.

>---<

Version 2.6
Enhancements
* When exiting the program on a remote with an active TCP/IP connection, the shutdown 

process now skips the save session prompt, allowing a quick and clean exit without 
disturbing the host and other remotes.

* Cleaner display switching between SAC and SAWStudio.

* A new option has been added to the Options Menu called Auto Save/Recall Shutdown 
Session. This option will auto save the current session settings to a background 
Shutdown.mxs file located in the SAC\Mix folder. When you restart the program, this file 
will be recalled resetting all mixer settings. Note the session name will reflect that you are 
inside the shutdown session file, not the original session file which may have been opened at 
the time. The original file was never overwritten unless you chose to manually save it before 
you exited the program. After activating this option, save the preferences.

* A new option has been added to the Options Menu called Background Auto Save Delay 
Time. This option allows you to set a delay time from 0 to 300 secs which will auto save the 
current session settings to a background AutoSave.mxs file located in the SAC\Mix folder. 
The option is turned off if the value is set to zero. The File menu now includes an option to 
open this AutoSave session file at any time. Note the session name will reflect that you are 
inside the autosave session file, not the original session file which may have been opened at 
the time. The original file was never overwritten unless you chose to manually save it before 
you exited the program. After activating this option, save the preferences.

* A new option has been added to the File Menu called Open Last Auto Save Session. This 
option allows you to open the last AutoSave session file if one exists from the activated 
automatic background save option. Note the session name will reflect that you are inside the 
autosave session file, not the original session file which may have been opened at the time. 
The original file was never overwritten unless you chose to manually save it before you 
exited the program.

* Added a trap for closing the program from the taskbar while the engine is still live, and 
added a display msg reminder that the engine is live to all program exit options.



* The Full Mixer labels now display in upper and lower case rather than forced upper case 
characters.

* Added popup fader option to the Dynamics gate and compressor threshold controls. Click 
and hold in the readout zones for these controls to popup the fader.

* A new option has been added to the Options Menu called Color Setup. This option allows 
you to set Mixer Channel Label Colors as well as the Mixer Hot Channel color (which was 
moved from the Mixer Menu). This option pops up a dialog listing 16 label colors and the 
hot channel color. Clicking in any one of the color squares pops up the Windows Color 
Picker dialog. You may change any of the colors and then click OK to exit and save the new 
color selections. If you click CANCEL, no changes will be applied. When color data has 
been altered a SAC_CustomColor.dat file is created in the main SAC folder. When using 
remotes, the color set of the Host machine will be sent to each remote when first connecting, 
so that session color information matches on each remote. When the remote disconnects, the 
original remote color set is restored.

* A new option has been added to the popup Chan Store/Recall Menu called Set Channel Label 
Color. This option allows you to select one of the 16 label outline colors for this channel or 
no label color. If this channel is one of a group of selected channels, then all selected 
channels will be affected. The default behavior sets this chan color for all mixers. If you 
press the Alt-Key when activating the menu choice, only the current mixer will be affected. 
This data saves with mix sessions, mix templates and with scenes. On scene recalls with 
active label properties, the chan label color will change with the label text. You might set a 
group of  vocals to one color and horns to another… etc. Or you may find it useful to just set 
the first vocal chan to a color and then the first horn chan to a different color to visually mark 
and separate the groups without flooding the label area with colors.

* Changed code to darken the small mixer label font. This does depend on what default fonts 
are installed on the system.

* Activated the Shades option on the File Menu. Those creating shades for SAC should name 
them SAC_xxxxxx.shd to distinguish them from SAWStudio shades. The xxxxxx being the 
shade name. The name of a loaded shade will be displayed next to the Shade Open menu 
option.

* Added an enhanced chan disable switch display which now draws a red X in the mixer chan 
number display zones at the top of each mixer view.

* Added support for the 3M MicroTouch 10 finger touch screen. Now you can grab multiple 
faders at once onscreen with your fingers. I recommend you set the Touchscreen mode in the 
Mixer Menu to avoid faders snapping to your finger position.

You must install the MT7 drivers and select Legacy Mode when asked. I also recommend 
you then use the driver calibration tool to calibrate the touch screen and also set the double-



click area to about 50% of the slider bar.

Some useful gestures built into the SAC MT7 driver support to learn and practice are:

Right-Click… done by tapping two fingers held very close together in a short single tap 
movement. The finger to the left is the actual right-click screen point, so you can use this as 
the actual tap position as if you right-clicked with a mouse pointer at that specific screen 
position. There is only a single tap, but both fingers must hit the screen at the same time.

Right-Hold… done by creating the right-click two finger gesture, but keeping the fingers in 
contact with the screen… the left finger is the important touch position. This can then be 
used for vertical scrolling the Zoom Mixer window, by sliding the finger up or down in the 
same manner as when using the mouse. Only the left finger needs be held on the screen once 
the two finger right-click gesture is recognized.

Left-Flick… done by a single finger touch and a quick flick motion to the left with the finger 
dragging on the screen. This can be used in the mixer views to page flip the current mixer to 
lower chan numbers. For instance… if 8 Z-Mixer chans are visible and the start chan is 
currently chan 9, this gesture would flip the view to start on chan 1.

Right-Flick… done by a single finger touch and a quick flick motion to the right with the 
finger dragging on the screen. This can be used in the mixer views to page flip the current 
mixer to higher chan numbers. For instance… if 8 Z-Mixer chans are visible and the start 
chan is currently chan 1, this gesture would flip the view to start on chan 9.

* Added new options on the Options Menu called Touch Device Setup, 3M MicroTouch 
Resolution, 3M MicroTouch X-Offset, and 3M MicroTouch Y-Offset. These options allow you 
to specify the resolution you have set for the 3M MicroTouch screen, and the X and Y offset 
values in case the screen is set as a secondary monitor in a left/right or up/down position. 
These options all save with the preferences.

* Extended user rights for setting the Solo Bus Master Level to FOH, MON-FOH and MON 
status.

* Added a new item on the Mixer Menu called Dither. This option will add a 1 bit random 
dither noise pattern to the output device buffers. Unfortunately, the newer Behringer 
ADA8000 units (since Dec 2009… Date Code 0912) have changed the audio codec chip to a 
new Cirrus Logic chip. This chip has become popular in other devices as well. This chip is 
supposed to be of higher quality than the previous codec, but has a default Auto Mute 
behavior which mutes the DAC side of the chip when it sees a series of 8192 zero data 
buffers. The chip then un-mutes when it sees new data with non-zero values. Unfortunately, 
the un-muting can behave in a random fashion and actually ramp up in a slow manner like a 
slow timed release gate… sometimes taking 3-6 secs to open up completely depending on the 
audio material. The chip can be programmed to disable this so called feature, unfortunately 
the Behringer units do not do this at this time (currently July 2010). This behavior causes the 
initial attack of playback material, or solo material to be lost for a random amount of time. 



Any audio software that starts and stops playback will miss the first audio attacks. The dither 
option can be activated in SAC to keep the chip active at all times, fixing this otherwise 
annoying behavior. Unfortunately, there is no current method for fixing this behavior within 
SAWStudio, the Media Player, I-Tunes player, or any other audio program that starts and 
stops playback. Hopefully Behringer will address this issue, and hopefully other hardware 
products using this chip will properly disable this behavior. If you have newer ADA8000 
units that exhibit this missing data behavior on startup or on the solo bus, activate the Dither 
option and save the preferences.

* Group and Latch data is now remote aware. Groups and Latches set on the host will now be 
transmitted to the remotes and vice versa.

* Remotes of any user status can now save and open their own preference files.

* The install now includes some basic mix templates to make it easy to start a new session and 
assign chan sources in groups of 8 chans. When starting a new session, just use one of the 
basic mix templates found in the SAC\Mix folder.

Eq Plugin Version 3.2
* Added a new option to the Options menu called Clear Preferences, which clears the 

preference file and resets the plugin to its default behavior.

Echo Plugin Version 3.2
* Added a new option to the Options menu called Clear Preferences, which clears the 

preference file and resets the plugin to its default behavior.

Bug Fixes
* Fixed code to properly display the Main TitleBar Text filename whenever the network 

titlebar info is altered.

* Fixed code that was causing a slowdown on remotes when recalling scenes with fade times 
and active label options selected in the scene properties.

* Export Mix Data From SAWStudio thru the SACLink now correctly updates the Wide Mixer 
and Exploded Mixer views if they are visible on the current SAC workspace.

* Fixed code to properly display titlebar caption text in Message Boxes.

* Fixed code to keep the current mixer window active after resetting the default value within 
one of  the popup fader controls.

* Fixed Monitor Solo Fx Processing to extend buffer processing for a short time after the solo 
is disengaged to allow for meter decay on plugins with active meters.

* Fixed code to ignore old mute latch data from earlier version sessions and only respond to 
mute latch information when the current mixer is FOH or MON 1.



* Fixed code to properly update Full Mixer input source display bars on remotes when input 
sources are changed via scene recalls.

* Modified code to attempt to detect and reset socket buffers if the network data gets garbled 
for any reason, in an attempt to keep the host free from GUI lockups caused by a trashed 
network.

* Fixed code to stop midi controllers with chan select from chasing the onscreen hotchan when 
the hardware navigation link is off.

* Fixed code to stop redundant midi controller bank data from being sent to a hardware 
controller every time the onscreen hotchan is changed if the controller does not need to 
chase.

* Fixed code to force FX Plugins to properly chase when switching mixers.

* Fixed code to properly activate a key chan on a Levelizer patched in the Pst Fdr patch point 
while the engine is live.

* Modified code to handle higher performance Counter Frequencies that are now starting to 
appear on the newer i5 and i7 motherboards. All Performance Counter math is now handled 
completely in 64 bit math variables. This assures the accuracy of the CPU load percentage 
readout on these newer faster motherboards.

Eq Plugin Version 3.2
* Fixed code to stabilize patching the plugin from remotes and scene changes. Also made 

changes to keep the processing thread from being blocked during preset and paramset loads.

* Fixed code to stop host paramset corruption when canceling a load preset operation on a 
remote.

Echo Plugin Version 3.2
* Fixed code to stabilize patching the plugin from remotes and scene changes. Also made 

changes to keep the processing thread from being blocked during preset and paramset loads.

* Fixed code to stop host paramset corruption when canceling a load preset operation on a 
remote.

>---<

Version 2.5
Enhancements
* Doubled the size of the network communication buffers to help allow certain VST plugins to 

properly send and receive parameter sets between the host and remotes.



* Enhanced scene label recall to follow the current labeling scheme of adding any input or 
return chan FOH label change to all monitor mixers automatically without the extra need to 
select each mixer chan in a partial chan group.

* Enhanced code to allow remotes to now be exited with the File/Exit menu or titlebar X 
button without having to first disconnect from the host and without interfering with the host 
operation.

* Added a new option to the Scenes View options menu called Rename Current Scene. This 
option allows you to rename an existing scene and it will handle the details in the 
background by copying the scene file  to a new one with the new name and altering the name 
in the listbox. This method allows other sessions linked to the old scene file to still operate 
correctly. You must save and update the session to retain the scene listbox changes and the 
new scene file links.

* Enahnced the Scene Properties Dialog to clear all selected partial channels when closing.

Bug Fixes
* Fixed code to restore ontop windows properly when switching apps using the SACLink. This 

maintains correct operation of popup faders, Touch Panel view and plugin windows.

* Fixed code to allow ESC-Key to properly cancel the Keyboard Mixer window when first 
activating it with the M-Key.

* Fixed code to allow a remote to shutdown from the TaskBar Close command without 
stopping the host engine.

* Fixed code to assign the proper mixer on host when patching plugins from remotes. Previous 
versions placed every host plugin patched from a remote on Mixer 0.

Eq Plugin Version 3.1
* Fixed code to properly initialize Lo and Hi Cut Filters while the engine is live from scene 

recalls that patch or alter Eq Plugin settings.

>---<

Version 2.4
Enhancements
* Added a new window to the View Menu called Touch Panel. This floating window gives 

access to important keyboard functions when using a touch screen or tablet type laptop which 
covers the keyboard. The functions can also be used with a mouse if desired. The window 
position and an auto display option may be saved with the preferences file.





These icons function as the Arrow keys on the keyboard, and couple with the use of the 
modifier options next to them.



This icon opens a virtual keyboard for typing in labels and filenames.

0 1 2 3 4 5 6 7 8 9

These numbers function as the number keys across the top of the keyboard and can be used 
to switch monitor mixers quickly.

ESC

This icon functions as the Escape key.



This icon forces the taskbar and Windows Start Menu to the top if they are hidden. The Start 
Menu will close after a few seconds, leaving the taskbar available to jump to other programs.

CTRL Lite

This icon can be clicked to engage Ctrl-Mode. The lite will flash and as long as it is 
flashing, all mouse or touch actions will act as if the Ctrl-Key is depressed. Some functions 
may automatically disengage this mode when completed. Otherwise, clicking again on this 
icon will clear it and stop the flashing. This may be used in combination with the Shft and 
Alt Mode lites. Right-Clicking anywhere in the Touch Panel view will disengage all active 
modifier modes.

SHFT Lite

This icon can be clicked to engage Shft-Mode. The lite will flash and as long as it is 
flashing, all mouse or touch actions will act as if the Shft-Key is depressed. Some functions 
may automatically disengage this mode when completed. Otherwise, clicking again on this 
icon will clear it and stop the flashing. This may be used in combination with the Ctrl and 
Alt Mode lites. Right-Clicking anywhere in the Touch Panel view will disengage all active 
modifier modes.

ALT Lite

This icon can be clicked to engage Alt-Mode. The lite will flash and as long as it is flashing, 
all mouse or touch actions will act as if the Alt-Key is depressed. Some functions may 
automatically disengage this mode when completed. Otherwise, clicking again on this icon 



will clear it and stop the flashing. This may be used in combination with the Ctrl and Shft 
Mode lites. Right-Clicking anywhere in the Touch Panel view will disengage all active 
modifier modes.

F1 - F12

These icons function like the F-Keys and can be used to switch F-Key WorkSpace views. 
Coupled with the SHFT modifier, F-Key views can be created.

* Added another method which can set mixer variable controls to their default setting. Pressing 
the Ctrl-Key when grabbing and releasing a variable control will set the control to its default 
value. This new method can be done easily with the Touch Panel on a tablet laptop which 
covers the keyboard.

Bug Fixes
* Fixed code to properly update the FX Solo Patch window titlebar text color when 

overlapping windows are removed and when active windows are changed. 

* Fixed code to stop crashes when using a touchscreen and grabbing the faders at the zero 
position.

* Fixed code that could cause Fx Plugin corruption on the host when removing and re-
arranging Fx Plugins on the remotes.

* Fixed code to properly store and recall FX Plugin settings when using the Store / Recall 
options from the remotes.

* Fixed code to properly save FX Plugin settings when adjusting plugins from remotes with 
plugins not visiblly displayed on the host.

* Fixed code to properly disengage all active solos when clicking any engaged solo switch 
while pressing the Ctrl-Key.

* The SAC Remote program will now display SAC-REMOTE on the taskbar icon when 
running.

* Fixed code to stop crashes when keying from SAC channels in the Levelizer plugin under 
certain setup conditions.

Eq Plugin Version 3.0
* Fixed code to properly Save and Restore all plugin settings from remotes regardless of where 

and how the settings are altered.

Echo Plugin Version 3.1



* Fixed code to properly Save and Restore all plugin settings from remotes regardless of where 
and how the settings are altered.

>---<

Version 2.3
Enhancements
* Note: There are many low level format changes to Scene and other data files as well as 

graphics files, and as a result, version 2.3 is not backward compatible. Therefore, as a 
precaution, you may want to keep copies of current important session and scene files, as well 
as a copy of a complete version 2.2 install, in case there is trouble and you need to step back 
to version 2.2 for any reason. It is still recommended that you install this version directly 
over your current install in its original folder, but suggested that you first make a copy of the 
original install folder in case you have to step back.

* RML Native Plugin updates are now Remote network aware. The plugs must be installed in 
both the SAC host program and the SAC Remote program. All control parameters are now 
accessible from the remotes, as well as meter functionality. The native plugins must be 
specifically coded to utilize the new SAC API network control protocols. Currently the 
Echo/Delay, Graphic Equalizer, Frequency Analyzer and Levelizer have this new capability. 
You must download the new versions introduced at the time of this update.

* VST and DirectX plugins are now capable of being used on Remotes also. The plugs must be 
installed in both the SAC host program and the SAC Remote program. There are certain 
limitations when using these plugin types since the plugins themselves are not directly aware 
of the SAC network control protocols. Meters will not be functional on the remote. Controls 
can be changed on the remote and then must be updated to the host by Right-Clicking on the 
blue pyramid Options icon at the top of the plugin window. If plugin changes are made 
directly on the host, they will only be visible and properly updated on the remote by closing 
the plugin and re-opening it on the remote, or simply opening the plugin if it is previously 
closed.

* Enhanced code to now display the Mixer, Chan or Solo Bus of patched VST and DirX 
plugins. Be aware that experimental shades will cause display issues until they are updated in 
this area.

* Enhanced the Scene Properties dialog with new options. You now have separate options for 
the Chan Disable switch, The FX Pre and Pst console Bypass Switch, and each of the 
different label types per chan. I advise quickly going through important previously created 
scenes and checking the properties (Right-Click on the scene) and updating the new options 
as needed… especially where labels are used in the scene. You do not need to update the 
scene data itself… just the scene properties. Be aware that experimental shades will cause 
display issues until they are updated in this area.

* Further Enhanced the Scene Properties dialog with the ability to now update the Partial Chan 



data without previously having to recall and update the scene first. When the dialog opens it 
will now select the current partial channels. You can now clear or change the selected 
channel data in any way… adding or removing channels to the current data and then click the 
Channels Update button. This will modify the Partial Chan listbox to the new selections and 
when you click OK to close the dialog, the scene properties and partial chan info will be 
updated. If you click the Cancel button, nothing will be altered and the scene info will remain 
in its original state. Be aware that experimental shades will cause display issues until they are 
updated in this area.

* Added a new option to the Mixer Menu called Touch Screen Mode. This option forces you to 
touch the fader knobs accurately and will not attempt to jump the touch position to the knob 
as it does with the mouse click position. This will also adjust the popup fader window 
position to place the current knob under your touch position. This mode keeps you from 
radically jumping a fader when using a touch screen.

* The Recent Session FileList now leaves blank entries enabled so you can use the Shift-Click 
method to delete the entry.

* The remotes can now make the host connection and synchronize mix data with no sharing 
necessary. This new code serves the data from the host to the remotes, bypassing Windows 
file access rights. But… be careful with no sharing access, since you will now not have 
access to the host drives for saving session files AS something new in a new folder. Save AS 
and Save Copy AS will now force you to the remote local drive since it can not access the 
host drive without proper sharing rights. It is still recommended that you share all drives on 
both the host and remote machines.

This new code can also now allow remote connections across the internet. To connect across 
the internet you just need to forward the port SAC uses in your internet firewall router box to 
the host machine IP address. Sharing issues mentioned above apply also across the internet 
because you do not have access rights to see the host drive directly.

* Enhanced the VST Plugin code to now allow midi data to be sent to plugins that can receive 
midi control data, even if they do not register as a VSTi synth. The Set Midi-In Port option in 
the popup VST Plugin options menu will remain active.

* A new option has been added to the Mixer Menu called Clear Current (Or Selected) Mixer 
Labels. This option will clear all labels or selected chan labels on the current mixer.

* A new midi controller template has been added to allow two MotorMix controllers to be used 
at the same time for 16 channels of control. The MotorMix units must be upgraded with a 
new internal ROM chip available from MotorMix in order for this to work.

Eq Plugin Version 2.9
* Enhanced code to allow remotes to control the plugin controls.

* Enhanced code to now display the Mixer, Chan or Solo Bus of the patched plugin.



Echo Plugin Version 3.0
* Enhanced code to allow remotes to control the plugin controls.

* Enhanced code to now display the Mixer, Chan or Solo Bus of the patched plugin.

Bug Fixes
* Modified code to not loose the 30th recent session from the list when opening one of the 

existing sessions on the list.

* Fixed code to trap for repeated session saves from multiple remotes or even saves executed 
rapidly before the previous save command has completed.

* Fixed code to place the Pre FX patch routing after mono processing when placed at the top of 
the module before the Eq and Dyn. This stops signal bleed from the associated L-R signal 
when using mono input settings.

* Fixed code to retain the current active window focus after saving F-Keys.

* Fixed code to retain the current active window focus after recalling chan settings from a file.

* Fixed code to stop interaction of Personal Monitor Mix solos with FOH and other monitor 
mixers.

* Fixed code to display meters correctly on PER-MON assigned remotes.

* Fixed Code to properly update midi controller labels after a scene change on controllers that 
have displays.

* Fixed code to clear the correct current mixer when this command is activated from a remote.

* Fixed code to properly update midi controllers with chan select displays when changing hot 
channels.

* Fixed code to properly update midi controllers with displays when changing chan labels.

* Fixed code to properly control Mute Thru Latches with scene recalls.

* Fixed code when using the Fx Bypass switch with multiple channels selected to only update 
the switch bypass condition on channels with patched plugins.

* Fixed code to clear monitor tap buffers that are earlier taps than the SS Rec/Play tap setting 
for SS Source tracks. This eliminates random buffer noise output on monitor mixers with 
source taps set before the SS Rec/Play tap setting.



* Fixed code to help eliminate pops on the first buffer of SACLink playback involving SS 
Input Track sources.

* Changed code to help with activating another application on the first click when switching 
from SAC.

* Attempting to update Scene Properties from a remote with improper sharing rights will now 
display a warning and cancel the attempt.

* Fixed Zoom Mixer Return module graphics to align Out Assign switches 1 and 2 to match 
the Input module.

Echo Plugin Version 3.0
* Fixed code to properly dissolve Feedback delays as they near -infinity db.

>---<

Version 2.2
Enhancements
* Modified code to default the Gate Threshold to inf instead of zero db, so that engaging the 

Gate Switch would not immediately mute the signal. The snap-to default Right-Click now 
also defaults to inf.

* The Host machine now allows engaging and disengaging TCP/IP Host mode without forcing 
the current mixer to FOH.

* Enhanced code to automatically generate a default set of workable F-Keys that stretch to fit 
the current screen resolution. This eliminates the need for multiple default F-Key files that 
come with the install and allows for the ever changing screen monitor resolution standards.

* Enhanced Mixer selection. You can now change mixers by using two number keys (not on 
the NumPad) in sequence. The mixers are numbered from 00 (FOH) to 24. After pressing the 
first number key, a mixer list will be displayed with mixer labels. The list will be hi-lited to 
display the range of active remaining selections. Press the second number key to select the 
desired mixer. For instance, if you first press 1, then the list will display the mixers 10 to 19 
hi-lited and expect the second number for the desired mixer. You can also press the M-key 
(Mixer) to pop the list up as a reference, and then enter the two number keys.

* Optimized the processing engine further to drastically reduce cpu loads on large dense 
sessions with many active monitor mixers. Have seen reductions on test E8400 systems with 
64 active input chans and 16 mixers by as much as 30%.

* Changed color of titlebar on Monitor Mixers to a deep red.

Bug Fixes



* Modified code to display Session Saved message without blocking meter display updates.

* Modified code to compress the network data required for remotes to handle multiple 
channels of Mute-Latch changes. This should drastically improve performance of these 
control updates on Wireless G and slow networks.

* Fixed code to properly clear Pst Fx plugins with Fx Scene recalls on all scene active channels 
that have no Pst plugins patched.

* Fixed code to properly link parameter changes with Fx Scene recalls to the proper plugin 
instance when multiple duplicate plugins are patched.

* Fixed code to properly recall multiple selected channels with multiple Fx patches using the 
Recall from File or Memory Cell function.

* Fixed code to properly set the Meter Taps from SAC Remote.

* Fixed code to properly update mixer titlebars on monitor mixers when changing the master 
output 1 label.

Eq Plugin Version 2.8
* Fixed code to properly initialize all parameters when loading presets while the engine is live.

* Code modified to stabilize sending and receiving parameter set data for preset saves and 
loads while the processing engine is live.

Echo Plugin Version 2.9
* Fixed code to properly initialize all parameters when loading presets while the engine is live.

* Code modified to stabilize sending and receiving parameter set data for preset saves and 
loads while the processing engine is live.

>---<

Version 2.1
Enhancements

* Caution: The Mix Session, Mix Template, Scene and F-Key file formats involve version 
changes with this release. The main Graphics.dll library has also been modified. These older 
formats will internally convert to the newer formats when opened, but once they are re-saved 
in this version they will no longer work with older versions. Please consider keeping copies 
of your current important files in case you must return to the older version for some reason. 
Once you have tested this version and are secure that all is stable, then you no longer need to 
bother.



* Enhanced the FOH and MON Solo bus to now accept FX Plugins. A new FX Solo Bus Patch 
window has been added and can be displayed from the View menu. This window is savable 
with F-Key views. This window allows you to now display either the FOH or MON solo bus 
and add FX patches to them. These FX will only process whenever a solo is active, and for 
about five seconds of blank buffers after the solo is released, to allow plugin meters to decay 
back to infinity after the signal goes away. This design then releases any FX cpu load when 
solos are not engaged.

* Enhanced the Sub Out Assigns to now accept multiple Master Outs at the same time, so each 
Sub Out chan can be assigned to any number of Master Out chans simultaneously.

* Enhanced the F-Key Workspaces with F-Key Properties Flags to now allow links to Vertical 
Offset, Start Channel, Mixer and HotChan for each F-Key. Now when saving an F-Key 
Workspace, the F-Key Properties dialog will display allowing you to set flags to link to 
Vertical Offset (forces each mixer view back to its current vertical offset), Start Channel 
(forces each mixer view back to its current start channel), Mixer (forces the mixer back to the 
current mixer) and HotChan (forces the HotChan back to the current HotChan). When 
recalling this F-Key, if any of the properties are active, then those properties will be forced 
along with the F-Key view changes. Note that if any mixer view is locked when restoring an 
F-Key, it will ignore active Start Channel properties.

* Enhanced the Solo Bus mode with a few new options. Solo Bus – Pre Fader (Input-Return) / 
Post Fader (Output). This mode solos Input and Return Channels Pre Fader and Output 
Channels Post Fader. This mode is similar to most current live mixing consoles normal PFL 
mode. Solo Bus - Post Fader (Input-Return) / Pre Fader (Output). This mode solos Input and 
Return Channels Post Fader and Output Channels Pre Fader. This mode is similar to a solo-
in-place mode but without other channels being muted. It maintains a fairly constant level 
between input, return and output chan solos and keeps the chans stereo image within the mix. 
Output Post Fader Solo Tap At Post-Fx . This option taps output post solo modes after the 
Pst-Fx patch point. The default mode for post-fader solos is pre of the Pst-Fx patch. This is 
useful when you do not want to hear various output monitor eq patches in your solo 
monitors, that may be inserted strictly to adjust for different monitor speakers and in-ear 
monitor variations. Activating this option taps the post solo signals after the Pst-Fx so you 
will hear any Fx patched there. Clear Solo Bus Master Offset Chan. This option clears any 
preset Master Solo Offset Output Chan which is used as a latch that allows the master solo 
bus level to chase a specific output chan fader. You can set any output chan fader as the 
master offset chan by Right-Clicking on its solo switch and selecting the Master Solo Offset 
option. Very useful in a studio configuration where your solo bus device is the same as the 
Control Room. Setting the Master Output channel as the Master Solo Offset chan, will keep 
the solos chasing the control room volume when they interrupt the normal mix. You can also 
use this option to designate an extra output fader onscreen to control the master solo level 
instead of using the popup menus. All of these options can be saved in the preferences file.

* Enhanced the Scenes with two new Scene Properties options. Mixer Chan Order and Mixer 
Chan Labels. This now allows you to save mixer chan order and chan labels in scenes for 
later recall with the scene. These options affect all chans per mixer, so you must have the 



Mixer properties option selected for each mixer you want to affect. This can be very useful 
for doing festival type jobs where there is more than one band setup. Now each band can 
have a starting scene that can reset everything, including new chan labels and chan re-
ordering setups without having to stop the engine and load a new session file. If you are not 
using these features in a particular scene, turn off these scene properties options to improve 
scene recall performance.

* Enhanced the monitor tap points by modifying the Src Split into two different points, one pre 
attenuator (Src PreA) and one post attenuator (Src PstA). This allows completely 
independent mix control when using two engineers as FOH and Monitors.

* Modified the Pre-Fx Patch routing by moving the insertion point to the top of the signal chain 
when this option is engaged. This now allows full use of the Mono, Attenuator, Phase Sw 
and Swap LR features on VST synths, or other source plugins.

* Moved the Mono Switch grahic up under the Input Source pre attenuator, signifying the new 
internal routing.

* Enhanced the Remote TCP/IP protocol to now include chan re-ordering events. The host and 
remotes will now duplicate all chan re-ordering changes.

* Enhanced the Remote TCP/IP protocol to now include Clear All Mixers, Clear Current 
Mixer and Clear All Mixer Labels functions.

* Enhanced the Remote TCP/IP protocol to now include Pre-FX Patch Signal Flow and 
Eq/Dyn Signal Flow functions.

* Enhanced the Remote TCP/IP protocol to now include FOH and MON Solo Bus device 
assignment functions.

* Enhanced the Remote TCP/IP protocol to now send current solo data updates to the remotes 
when they first connect and if there are active solos when User Rights are changed while 
they are connected.

* Enhanced the SACLink protocol to pass necessary information between SAC and 
SAWStudio to allow for record loopback latency compensation and an overall more accurate 
record sync alignment during overdub recording using the SACLink.

* Enhanced the Input and Output Device selection menus to display currently used devices 
with a * next to the chan numbers. Mono devices will show the corresponding stereo pair as 
used when looking at the stereo device list. These lists will no longer disable unassigned 
hardware devices, so that you can now create mix sessions with full input and output 
assignments, even on a system with no audio devices installed.

* Added the ‘X’ key to the list of section jump keyboard shortcuts to jump up to the Fx section.



* Added 3 new menu items to the Mixer menu called SAC Link Rec / Play Tap At SRC PRE 
ATT, SAC Link Rec / Play Tap At SRC PST ATT, and SAC Link Rec / Play Tap At PRE FDR. 
These options control the record and playback tap point for SAWStudio using the SAC Link 
connection. The playback insert point when switching the input source to the SS Mixer Chan 
is now at the same place as the record tap point, therefore playback should return the exact 
signal back into the chain to facilitate the virtual band mix tweaking concept.

* Added one new category to the User-Rights menu called MON-FOH. This status places the 
user in the MON category, using the Monitor Solo Bus, but also allows FOH access. This 
allows two operators on the same system using two different solo buses, but now having the 
same access rights.

* Modified code to link bank switch functions from a hardware controller back to a mixer view 
if the controller is linked to that mixer view window in the Navigation Link options.

Bug Fixes
* More work done on code to eliminate possible save session failure and file corruption under 

certain conditions while the engine is live. If for some reason the save crashes, the original 
file will remain intact.

* Fixed code to clear FX Patch label displays when clearing all mixer labels.

* Modified code to trap for TCP/IP packet splitting of long command string data that could 
cause corruption in the command execution under certain conditions.

* Modified code to keep host and remote machines with different user status from interfering 
with each other’s solo activities.

* Fixed code for midi hardware controller links to specific mixer views that now correctly links 
the controller to the mixer view start channel.

* Fixed the Rvs Gate code to work correctly when switching it on and off while the engine is 
live.

* Fixed code to ignore selected channels when using the Duplicate Mixer Chan Order function, 
since chan order is global for all channels of a mixer.

* Modified code for loading VST Presets and forcing a screen update of the new settings for 
certain plugins that would not update properly on their own.

Eq Plugin Version 2.7
* When SAC was in Realtime Priority mode, certain system configurations could cause the 

left-click up/dn parameter adjustment feature to fail. This code fixes that issue.

Echo Plugin Version 2.8
* When SAC was in Realtime Priority mode, certain system configurations could cause the 



left-click up/dn parameter adjustment feature to fail. This code fixes that issue.

>---<

Version 2.0
Enhancements
* Enhanced the SACLink Export SAC Mix Data function to only export active chans (chans 

which have active input source assignments and are not disabled). If selected chans exist, 
only those active chans will be included in the export.

* A Scene name parser is now included which blocks illegal scene names. Scene names must 
also be legal filenames with only numbers, letters, spaces, underscores, hyphens and a few 
other specific punctuation characters allowed. Entering a new scene filename that contains 
illegal characters will flag you with a message listing all legal characters you can use and 
then allow you to re-enter the name, or cancel.

* Chan labeling has been enhanced. When labeling the FOH or Monitor Mixer 1 (used as the 
master monitor mixer) , Input and Return chans will pass thru to the following monitor 
mixers by default. But, when starting the label process using the Alt-Key along with the Shift 
or Ctrl options, the label will not pass thru to the following monitor mixers, allowing you to 
make label changes on the current mixer without affecting other mixers.

Bug Fixes
* More work done on saving VST settings and presets. This new code should fix compatibility 

issues with Voxengo plugins and UAD plugins (and others) that were having trouble saving 
presets and session settings.

* More Work done on VST Multi-In/Out plugins like some of the newer Voxengo plugs to 
stop the possibility of a hard crash once playback is initiated.

* More work done on retaining the last active window when switching between apps using the 
SacLink or minimize functions.

>---<

Version 1.9
Enhancements
* Clearing a mixer’s Channel Re-Ordering (Ctrl-Left-Click on a channel number in the Full or 

Zoom mixer) is now prompted… you can answer NO to cancel the operation.

* FX Plugins can now be controlled within the Scenes. A Scene now saves and recalls the 
patched plugins and plugin settings. If the plugin patch list stays the same within a mixer 
channel from scene to scene, the plugin patches will not be altered and only all the plugin 



settings will be saved and recalled. If the plugin patches on a channel are different from 
scene to scene, the patch list will be cleared and the new plugin patches will be recalled. 
Therefore, you can actually have a scene add or remove plugin patches from any mixer 
channel, as well as only alter plugin settings. The appropriate FX Pre and FX Pst options in 
the Scene Properties window must be active for the Plugins to be affected by the scene recall.

* Enhanced the SACLink function to now allow the SAWStudio Control Track to recall 
scenes.

* The DirectX Plugin options menu is now available while the engine is live for loading and 
saving presets on the fly.

* Added modifications to allow compatibility with new Waves 6 VST plugins. The plugins 
need to first be extracted from the Wave Shell using the Shell2VST utility.

* Enhanced the Navagation Links options in the Mixer menu. You can now choose a link to 
HotChan option for each individual Mixer view and Midi Hardware controller. When a link 
is active, the mixer view will chase the HotChan no matter where it is changed from. If a link 
is not active, then the view will stay frozen and not chase the HotChan when changed from 
some other view, but will still allow you to change channels within the window view itself. 
The views can also be locked by Right-Clicking on the window Close button. The lock can 
be easily toggled for a quick temporary override of the link status. The Midi Hardware 
controller can also be locked to a specific Mixer view and will only chase that mixer, 
remaining frozen in position to the HotChan of that view. Combined with the use of the lock 
option, this offers some exciting controller operational flexibility.

* Added the ability to scroll thru channels in the Exploded Mixer view with the wheel mouse 
or Left-Right-Arrow keys. This view can now also be locked by Right-Clicking on the 
window Close button.

* The “Save As” and “Save Copy As” commands now detect if the new save destination is in a 
different folder and will automatically extract and save all the session scene files in that new 
folder within the Save operation.

* Added a new option to the Scenes Options popup menu called Disable SpaceBar Scene 
Recall. This will disable the spacebar from activating a scene recall, and can be saved with 
the preferences.

* Enhanced the TCP/IP network threads to prevent the host interface from locking up when a 
remote machine goes down and crashes its connection and/or otherwise freezes the network.

Echo Plugin Ver 2.7
* Modifications made to properly update settings display on an open plugin altered by a Scene 

change.

Graphic Eq Plugin Ver 2.6



* Modifications made to properly update settings display on an open plugin altered by a Scene 
change. Also now allows the Options menu to open while the engine is live.

Bug Fixes
* Fixed code to properly display Mute-Thru-Monitor-Latches when recalling scenes from a 

monitor mixer which is affected.

* Fixed code to correct monitor scene recall data from being improperly sent to the FOH midi 
controller.

* Fixed code for the Alt-Up-Dn-Arrow keys to work properly as a single chan control whithin 
a group selection or latch preset.

* Fixed code to hold the active mixer window focus after using one of the popup fader control 
adjustments.

* Fixed code to properly track midi controller bank change updates.

* Fixed code to eliminate crashes caused by adjusting the same control from two different 
entry points (mouse and midi, FOH and Remote, etc) at the same time.

* Fixed code to set all grouped channels to the same default value when using the Left-Right-
Click method of setting a control to its default. When setting a Group-Latch Out fader control 
to its default, the latched faders will still move relative of their current values.

* Right-Clicking on a DirectX Plugin TitleBar will no longer stop the engine.

* Fixed code to properly handle Output Grp Latch faders and all of their assigned latches when 
the Output faders themselves are selected (temp group) or permanently latched.

* Fixed code to correctly identify the FX windows as the active window with the yellow 
titlebar text.

* Fixed code to jump to the proper Right-Click I, R and O zone channels when channels are re-
ordered.

* Fixed code to stop crashes when a second SAWStudio attempts to auto activate the SACLink 
on start and SAC is already linked to another instance of SAWStudio.

* Fixed code to ignore source mono switches during Chan Template Memory or File recalls so 
mono input sources will not altered.

>---<



Version 1.8
Enhancements
* Changed the Audio Device Setup Window to display devices in groups of twelve at a time. 

This allows the window to fit on smaller screen resolutions comfortably.

* Enhanced the Update Scene operation and added the ability to override the Channel Partial 
data. When activating the Update Scene function, you will now be prompted whether you 
wish to also update the channel partial data to the currently selected channels or leave the 
original channel partials intact. If you answer YES, then the current channel selection will 
overwrite the original scene data. If you answer NO, then the original channel partials will be 
automatically selected and displayed for you and the scene update will maintain its original 
channel selection.

* Enhanced the midi control engine to accept the 32 chan Behringer midi control template. See 
helpfile for details of setting up multiple BCF2000 units.

* Enhanced the midi control engine to force the mixer screen display to line up the midi 
controller start chan to the left edge when changing channels or banks from the controller 
itself.

Bug Fixes
* Fixed code that could randomly corrupt scene properties of an existing scene when using the 

Update Scene operation.

* Fixed code to properly display mutes that are latched thru to monitors when recalling scenes 
with fade times.

* Fixed code to stop sending hardware controller refresh data every time the HotChan is 
changed if the link to hardware controllers option is not active.

* Fixed code to pass output group fader and fader latch controls to hardware controller faders 
when a group master is adjusted on the hardware controller itself.

* Fixed code to handle Mute Latch Thru To Monitors options when midi controller hardware is 
used to activate the mute switch.

* Added a slight delay at shutdown to allow slower midi drivers a chance to clear midi 
controller data before closing the program.

* Fixed code to properly repaint mixer top client mixer label zones whenever labels are cleared 
or entered, including maintaining selected channel status.

>---<



Version 1.7
Enhancements
* Enhanced the Mixer Solo Bus Device menu displays to show channel and device numbers 

for the current selections.

* Enhanced VSTi Synth features allow multiple VSTi synth plugins on different SAC channels 
to connect to the same midi port for sound layering.

* Added code to support multiple chan outputs from VSTi synth plugins. You assign the extra 
out chans from the VST plugins Blue Pyramid Options menu using the Assign Soft-synths 
Multi-Out Chans option. These extra outs are automatically processed on the next adjacent 
SAC channels from where the plugin is originally patched. For example, if the plugin is 
patched on Chan 3 and it has 3 separate stereo outputs, these extra out signals will process on 
SAC channels 4 and 5. You must assign each of those channels input source to FX Source in 
order to activate the channels into the engine loop. With all VSTi Synth plugins, you may 
also wish to set the Mixer Pre-FX Patch Signal Flow options for those channels so the synth 
signal inserts at the top of the channel module and passes thru the EQ and Dynamics 
sections. All VSTi synth plugins should be patched in the Pre-FX patch window.

* The Import Scene feature has been enhanced to allow you to copy scenes from one mix 
session spinoff to another within the same folder. If the scene file is already found in the 
current scenes folder, you will be given the option to adjust the name. If you choose NO, 
then the existing scene file will be linked into the current mix session. If you choose YES, 
then you can change the name and create a new scene file.

Bug Fixes
* Fixed code to allow the Channel Mute Latch settings to work properly with Scene Recalls 

and to keep older scenes from changing the Mute Latch settings.

* Fixed code to allow SpaceBar scene recall to function even if the main window is the current 
active window. Also corrected the Mixer views to handle the Alt-Key SpaceBar recall to 
bypass scene fade times.

* Fixed code that could randomly keep meter thread initializations from loading properly, 
which would cause meter displays to stop working, even though the audio engine was 
operating correctly.

>---<

Version 1.6



Enhancements
* The Output Group Latch feature has been enhanced. Using the Left-Right-Click feature on 

an Output Group Latch fader will now return the fader to its default zero db position and 
offset the latched fader channels by the same amount of change. This can be useful to return 
all latched channels to a starting default position after having made mix adjustments. Notice 
that using the Alt-Key when adjusting the Output Group Latch fader itself will disengage it 
from the latched channels allowing you to position the master latch fader to any offset 
starting position.

* A new Mute-Thru Monitors Latch option has been added to the Mute switches. Right-
Clicking any Mute switch on the FOH or Monitor Mixer 1 console view will display the 
Mute-Thru Monitors Latch option. If this is activated on an FOH channel,  that channel’s 
mute switch will always latch thru to all monitor mixers regardless of the mixer tap point. If 
this is activated on a Monitor Mixer 1 channel, that channel’s mute switch will always latch 
thru to all the rest of the monitor mixers, independent of the FOH mixer. In this way, you can 
maintain the separation between a Monitor and  FOH engineer. This option can be very 
handy for RF mic channels, for example, where it may be desirable to mute those channels in 
all monitor mixers with the press of the FOH mute switch, even though the monitor mixers 
are tapped at SRC or other points that normally do not follow the FOH mutes.

Echo Plugin Ver 2.6
* Enhanced the Delay ms popup menu to display a reference distance in Feet or Meters 

(selected in the Pyramid Logo Options menu) based on the speed of sound through dry air at 
68 degrees F (20 degrees C).

* A new Tap Mode feature is available by clicking on one or both of the Tap Lights (Pressing 
the Ctrl-Key while clicking on either will activate both channels). When this mode is 
activated, you can click the Left Mouse button in the Tap zone between the Tap lights twice 
in succession, or tap the Left, Right, Up or Down Arrow keys twice in succession or the 
SpaceBar twice in succession or any combination of those keys once each for quicker 
response times and the delay time will be calculated between taps. You can leave this mode 
active and tap a new delay at any time. If the time between taps is longer than the max delay 
time for your specific samplerate, then the taps will be ignored.

* Enhanced the DelayTime,  FeedBack and Strength controls to stereo latch when using the 
Ctrl-Key and any of the control adjustment methods.

* The Pyramid Logo Options menu may now be used while the engine is active.

Bug Fixes
* Fixed code to stop a NO_ACCESS remote station from being able to toggle Live Mode 

On/Off.

* Fixed code to keep the Meter Tap Point adjustment working beyond the first attempt on a 



remote station.

* Fixed code to stabilize remote automatic connection when this option is saved with the 
preferences and not interfere with the host operation.

* Fixed code that was stopping the Signal Switch plugin from displaying it’s about window.

* Fixed code to properly set Wide Mixer window size when the default F-Keys have been 
saved with the Wide Mixer set to a Return or Out channel.

* Fixed code that could cause looped buffer noise on Monitor Mixers 2-24 that are assigned to 
tap from the Monitor 1 mixer and the FOH Input channel source is switched to OFF while 
the engine is live.

>---<

Version 1.5
Enhancements
* Enhanced the Mixer Group popup menu (Left-Click Mixer Titlebar) with new options for 

creating Latch Group Presets. These work similar to group presets but add the power of 
automatic latching anytime one of the preset latched channels is adjusted. These latched 
groups do not require pre-selection before adjusting controls, the latch between channels is 
automatic when any one of the latch preset channels is adjusted. The latch presets are set in 
the same manner as the group presets, simply pre-select the channels you want as part of the 
latch and then Shift-Click the latch preset choice and enter a latch name. You can select the 
latch preset exactly as with group presets by simply Left-Clicking on the latch preset from the 
popup menu. These latch presets can be very handy for creating stereo-latched L and R 
channels which will then always adjust the pair simultaneously. You may override the latch 
at anytime by using the Alt-Key as you adjust channel controls. These latch presets save with 
Mix Template and Mix Session Files.

* Solo Bus mode has been enhanced with the ability to set individual solo levels for each chan 
of each mixer. Right-Clicking any mixer Solo Switch when in Solo Bus Mode will display a 
popup menu of level settings for that channel’s solo bus send. This data is stored with the 
mixer settings and is saved with Mix Session and Mix Template files. This can be very useful 
in balancing input chan solos against output chan solos, or low level signals against high 
level signals in Pre Bus mode.

* Enhanced the channel store/recall memory cell count to 8.

* Adjusted the Return Chan Monitor Pre Fader Tap Point to be post mute for consistency with 
the Input Chan operation.

* Activated the command line processing to accept a .mxs filename for automatic loading at 



startup.

* The current TCP/IP mode can now be saved with the preferences, allowing this mode to be 
automatically activated at program startup.

* The overall solo bus level can now also be set by Right-Clicking the master solo light in the 
main top client area when either of the solo bus modes are active.

* Meter Response, Meter Tap Points, Solo Mode and Solo Bus Level are now all activated in 
the TCP/IP protocol, allowing these options to be set from remote stations.

* Adjusted code to allow the program to run in a 1024 x 600 resolution to accommodate the 
new inexpensive NetBook computers and mini Notebooks for use with SAC Remote.

* Added some keyboard commands in the Z and F mixer to jump the Z and E mixers to the 
different channel strip sections. Pressing the I-Key now jumps to the Input/Attenuator 
section; Pressing the E-Key now jumps to the Eq section; Pressing the D-Key now jumps to 
the Dynamics section; Pressing the A-Key now jumps to the Aux section; Pressing the O-Key 
now jumps to the Output Assign section; Pressing the L-Key now jumps to the Label section; 
Pressing the F-Key now jumps to the Fader section.

Bug Fixes
* Fixed code to reset live assignments when using the Clear Current Mixer option while the 

engine is live.

* Fixed code to properly shut off the special Output Chase Solo Mode from remotes.

* Fixed code to keep focus on the current mixer view when pressing the spacebar for scene 
recall from a mixer view.

* Fixed code that would lock up remote network data when the About Window was open.

* Fixed code to stop the main titlebar text of a long session name from overwriting network 
display icons on a low resolution screen.

* Fixed code to correctly display the monitor mix name in the main mixer client area when 
connecting from a remote with a PER-MON user rights status.

>---<

Version 1.4
Enhancements
* Added the Current Mixer info to the F Mixer, Z Mixer and W Mixer titlebars.



* Removed the Clear Current Channel from the Mixer menu and added the new Clear Current 
Mixer to the Mixer menu. This option clears only the current mixer, including the monitor 
Master Out 1 label if the mixer is a monitor mixer.

* Consolidated and optimized code for a smaller memory footprint.

* Enhanced network data handling for more efficiency across wireless networks… including 
Wireless-B, G and N.

* Enhanced the special Output Master Solo Mode. Left-Clicking the Solo Light in the main top 
client area now turns the light green and engages a special Output Master Chan Solo Mode. 
The first Master Out Chan will be soloed so you can hear the main mix for the current mixer. 
Engaging any other Master Out Chan solo will add that to the Master Out Solo Template for 
that mixer and will automatically recall each time you engage the special solo mode. While 
monitoring in this mode, engaging any input chan, return chan, or non-master out chan will 
override the master out solo and act as a normal solo per chan. When disengaging the last of 
these solo switches, the original special Master Out solo mode will be automatically reset. If 
you change mixers while in this special solo mode, the Master Out Chan Solo mode will 
chase to the new mixer allowing you to monitor its Master Out Solo Template. Left-Clicking 
the main top client Solo Light again will disengage this special solo mode.

* Enhanced the Mixer Menu Meter Tap Point option to allow separate settings for Input/Return 
chans and Output chans. This can be quite handy for example, to monitor input src signals to 
set mic pre gain trims, while at the same time monitor output pst fader levels to see actual 
mix levels being sent to the amps.

* Enhanced the network remote interface to allow for remotely opening and saving host 
session files or remote local session files.

* Enhanced the SAC-Remote memory allocation code to allow using the remote program on a 
machine with a min of 128 megs of Ram.

* Added code to handle Open and Save Mix Templates from a remote machine.

* Added more remote access rights checking for certain menu items. Certain options have now 
been locked out from Monitor and Personal Monitor remote stations.

Echo Plugin Ver 2.5
* Enhanced the Delay ms popup menu to display a reference distance in Feet or Meters based 

on the speed of sound through dry air at 68 degrees F (20 degrees C).

* The Delay ms popup menu now offers a Tap Mode selection. When this is selected, you can 
tap the Left-Arrow followed by the Right-Arrow and the delay time will be calculated 
between taps. Press the Esc key to exit this mode.



* Enhanced the DelayTime and FeedBack controls to stereo latch when using the Ctrl-Key and 
any of the control adjustment methods.

Bug Fixes
* Fixed code to lockout remote computer access to all windows and host control functions 

when the remote has a NO ACCESS UserRights setting. If the remote fails to open the host 
current session file, it will be demoted to a NO ACCESS UserRights setting. The remote 
machine must have a proper network connection with read and write access to the host 
machine, and must be already logged in to the host if it has a password account on the host 
machine, prior to a SAC host connection.

* Adjusted meter code for more accuracy when using the Sac-Link with SAWStudio.

* Fixed code to eliminate meter and audio driver freeze when the engine is left running for 
infinite periods (more than 24 hours).

* Fixed code to properly display the Scenes Titlebar text in yellow when the it is the current 
active window.

* Fixed code that could corrupt fade times under certain conditions when updating an existing 
scene.

* Fixed code to properly display All or Partial chan selections in the scene properties window 
when updating a scene.

* Adjusted code to force Main window active after plugin initialization to fix display issues 
caused by the JMS HiRes Eq and possibly other native plugin initialization routines.

* Fixed code to properly integrate output chan XY Pan assign switch toggles into the live 
engine loop without having to stop and restart the engine.

>---<

Version 1.3
Enhancements
* The Eq display has been modified to label the Q control as BW for BandWidth as a more 

accurate reference of its function.

* The Output Assign Switch numbers have been colorized to denote the master and sub outs.

* The I, R and O zones have been enhanced to use the Right-Click to emulate the original Alt-
Key variation, which will snap you back to the last chan in that section that you were 
previously using, and the Shift-Key variation on repeated consecutive clicks in the same 
zone, which will increment to the next chan in that zone.



* The Spacebar-Key, to recall a scene, will now operate from all mixer views as well as the 
Scene view.

Bug Fixes
* Fixed code to properly handle selected Chan imports from the SAC-Link SAWStudio mix 

data exports. If there are selected chans in SAWStudio when activating the SAC-Link Export 
Mix Data To SAC function, only those chans in SAC will be affected.

* Fixed Hot Chan Solo Mode to turn OFF correctly when the solo light is left-clicked again.

* Fixed code to clear playback buffers when SAWStudio playback reaches the last region of 
data or is stopped when using the SAC/SAWStudio Link.

* Fixed code to properly clear meter peaks from SAC Remote.

* Fixed code to properly display Chan label in Signal Switch plugin.

* Fixed code to hide all ONTOP windows when switching apps.

* Fixed code to correctly set the scene properties for the current scene when using the update 
scene function.

* Fixed code to trap F-Keys when program is minimized.

* Fixed code to allow windows to activate on first mouse click when switching between 
hide/show floating app windows.

* Fixed code that traps for ‘not assigned’ audio devices in the device setup list and handles the 
driver open function correctly.

* Fixed display of Input Sources for scene recalls which would not display properly under 
certain conditions on some mixer views.

>---<

Version 1.2
Enhancements
* XY Pan routines are properly integrated into the new engine.

* Touching any control that is part of an active Scene fade will now disengage and override 
that control.

* Selected Group and Sub Group Latch functions will now also operate from a midi controller 
surface.



* The Full Mixer view may now be sized down to 1 module. This makes it useful in a large 
Zoom Mixer workspace as a module section jump toolbar.

* Only Remotes with FOH or MON status can now start and stop the live engine.

* Remotes will now display the host slipped buffer counts when asked.

Bug Fixes
* Fixed code to improve speed of meter resets on remote machines by sending only specific 

mixer view resets that the remotes are viewing.

* Fixed code, that could cause a crash, to correctly disengage and override any control in a 
scene fade that is also part of a currently active scene fade when the new scene recall is 
started.

* Midi Controllers on host and remote machines will no longer interact unless both systems are 
viewing the same mixer at the time controls are moved.

* Fixed code to allow Midi Control Surfaces with section jump functions to correctly jump to 
the next or previous section even if the mixer channels are re-ordered.

>---<

Version 1.1
Enhancements
* Moved the [SAW-Link] menu option to the front of the main menu for more consistent 

placement between SAC and SAWStudio.

* SACRemote no longer needs plugins installed on the remote machine. It will read the list of 
plugins from the host. You can Add, Remove, Clr and Move plugins from the remote 
computers, but remote display and control of plugins is not currently active, but coming in a 
future update. You can currently only use the FX bypass switches on any of the mixers.

Bug Fixes
* Fixed code to correctly save FX Source Input settings with mix sessions.

* Fixed code to properly display Input and Return Source settings when recalling a scene.

* Fixed code to correct for network bogdowns during remote hookup on certain Windows 
setups which would depend on network protocols installed.

* Code modified to fix possible crash issues with ASIO drivers and more than 72 channels of 
soundcard devices when opening the Audio or Sync Devices Setup window.



* Fixed the increment/decrement fader arrow clicks to properly increment in the Wide Mixer 
View Output Channels.

* Fixed code to clear remote computer meters when SAWStudio playback is stopped when 
using the SAC/SAWStudio Link.

* Fixed code to handle mixer FX Patch bar displays with scene recalls that contain active FX 
switch changes correctly, even if plugins have been removed.

* Fixed code to eliminate the delay on large sessions when starting the engine with active 
Host/Master/Remote TCP/IP connections.

* Fixed code to not flash remote meters as host mixer displays are changed.

* Fixed code to correctly display host devices in remotes for input and output device 
selections.

>---<

Version 1.0
Enhancements
* This is the first official release version.

* The Remote functions have been extracted to a separate SAC-Remote program. This 
program is free to all and available as a download on the SAC site. This program can be 
freely distributed and installed on desktop or laptop computers to be used as FOH, MON or 
Personal Monitor remote control stations for a Host/Master SAC system. The SAC-Remote 
version has no audio engine or hosting abilities and requires connection to a SAC 
Host/Master system to be functional, although all other interface functions remain the same 
and it is also a perfect way to learn the basic SAC interface and create session templates and 
scenes while run in stand-alone mode to be later imported into the main SAC sessions.

* The Channel Mute switch has been enhanced with the use of the Ctrl-Key. When you click 
on the Channel Mute switch while pressing the Ctrl-Key, the FOH and all Monitor mixers 
will be affected. This can be very useful for muting output channels or returns across all 
mixers at the same time. Temporary grouped channels will also respond to this feature.

* A new option has been added to the Options Menu called TCP/IP Computer User-Rights 
List. This option allows you to set user rights for the host/master computer as well as all 
remote connected computers. You can assign each computer by name and lock it’s user 
rights to FOH, MON, or any one of the Personal Monitor Mixers. These settings 
automatically save in their own .ini file each time they are altered. If a remote computer has 
NO ACCESS as its setting, all windows will be disabled. The computer will see signal 
meters but will have no control of the mixers and other windows. All remote computers start 



out with NO ACCESS status until the Host/Master computer sets the user rights in the 
TCP/IP Computer User-Rights List option.

* Solo Bus Mode has been enhanced to now offer two independent solo buses, one for FOH 
and one for Monitors. This allows a FOH and Monitor engineer access to the same host 
system with independent routing of solo selections. Any connected computer that has FOH 
User Rights will solo out to the FOH Solo Bus Device, while MON User Rights computers 
will solo out to the MON Solo Bus Device. There is now a new option in the Mixer Menu 
Solo Mode options to select a separate FOH Solo Bus Device and a separate MON Solo Bus 
Device.

* Remote computers with Personal Monitor User Rights now use a new enhanced solo mode 
that acts similar to Solo In Place mode. Engaging solo on a remote personal monitor 
computer will highlite the soloed channel in place by dropping the other chans 12 db. This 
allows the performer to stay in time with the rest of the performance while still hearing the 
soloed channel clearly above the rest.

* The TCP/IP Remote functions have been enhanced and optimized for performance by 
compressing the amount of data being sent across the network.

* The Monitor Mixers have been enhanced to now offer 8 master output channels just like the 
FOH Mixer.

* The Recall Chan settings from memory now ignores all device in and out assignments so you 
can now recall channel control settings from other channels without affecting input source 
and output device destinations.

* A new feature has been added to the Output Sub Faders (9 – 24). If not assigned to a master 
out as a normal sub group bus fader, the sub faders can act as a group fader latch, similar in 
function to a VCA sub. Any input or return chan assigned to the group bus will be controlled 
as a group by the sub fader. Pressing the Alt-Key while moving the group latch fader will 
temporarily disengage it from the group, and using the left-right-click feature to set the fader 
to its default value will also temporarily disengage it from the group. This concept allows 
you to set an offset limit by riding the group fader near the bottom or top of its range. The 
Mute and Solo switch will also operate on the group.

* The Scene operation has been enhanced to include a data filter that allows you to set which 
controls and switches are active within a scene and which mixers will be affected. You can 
also set a fade time for the scene in milliseconds and also select whether switches react first 
or last when a fade is active. Fades require the engine to be live since they use the sample-
clock for timing. The display will also show you the channel list of the scene’s active 
channels. You can see and adjust these options by Right-Clicking on a scene in the Scene 
View window. Once in the dialog you can click OK or use the Enter key to exit and save the 
changes or click Cancel or use the ESC key to exit and cancel any changes.

* Scene operations are now fully operational from remote computers and can maintain 



separation between FOH, MON and PER MON user rights.

* The Scenes View window has now removed the sorting status allowing you full control of 
the arrangement and grouping of your scenes. You can move scenes up or down in the 
listbox by using the Ctrl-UpArrow or Ctrl-DnArrow keys.

* The Scenes View window now also adds the SpaceBar key to recall a scene and the Enter 
key to display the Scene Properties dialog. The Delete key is also active to delete a scene. 
Using the Alt key when recalling a scene overrides any built-in fade time. Using the Ctrl key 
when recalling a scene will select the partial channels as a temp group.

* The Scenes View window Options icon has been activated with two new options. The Auto 
Advance After Recall option automatically advances to the next scene entry after a scene 
recall operation… perfect for stepping through a series of scenes in a show lineup. The 
Import Scene To Current Session option will copy a scene file from another folder into the 
current session Scenes folder and add the scene into the current session scene list.

* When a system is active as a Host/Master, you may now Left-Click on the Host/Master icon 
on the main titlebar to display a list of connected remote computers and their user-rights.

* Channel Label entry is now functional from remote computers.

* The meter code has been adjusted for a smoother response at all buffer sizes and slightly 
extended peakhold displays.

* Redesigned the Pre FX Patch signal flow option to insert the Pre FX Patch at the top of the 
module before the Monitor Src Split and SACLink Record Src Split. In this manner, a VST 
Synth can be treated as source data for the monitor consoles as well as for SAWStudio 
SACLink recording.

* Two new Input Source options have been added to the popup input source device menu on 
the mixer. The first option is called FX Source and is used to force the chan active with the 
source data expected to feed from an FX Plugin, like a VST Synth or Tone Generator. This 
option is added in place of the automatic VST detection method which could fail on many 
plugs that do not register as such correctly. The second option is called Off and is used as a 
quick way to disconnect the chan without having to open a stereo or mono device menu to 
select Off there.

* A new Main Menu option next to the Info Menu called [SAW -Link] is now available to 
switch to SAWStudio when the SAWStudio-SAC Link is active.

Bug Fixes
* Code modified to fix issues when importing SAWStudioLite data into SAC using the 

SACLink feature. This fix makes adjustments for the lesser channel count in Lite and 
corrects mis-aligned Input, Return and Output data.



* Fixed code to maintain a clean shutdown when a TCP/IP connection is active when you exit 
the program.

* Fixed TCP/IP initialization code to eliminate lockups that could occur while making a new 
remote connection while the engine is live. You are now free to connect or disconnect remote 
computers while the engine is live.

* Fixed Output Chan assignment readouts to correctly display master or group assignments on 
all mixer views.

* When creating a new scene, the code now checks the Scenes folder in the session folder and 
warns of duplicate scene files that may be used by other session spinoffs. If it finds a 
duplicate file, you have the option to adjust the scene name or cancel.

* Meter response changes can now be done while the engine is live.

* Deactivating meters while the engine is live will now properly clear the meters.

* Fixed code that would cause a crash with ASIO drivers when the total audio devices 
exceeded 24 (48 channels).

>---<

Version Pre-Release 0.3
Enhancements
* Added a new menu option to the popup Current Mixer menu (Right-Click in the Current 

Mixer Zone in the Main Top Client Area). The option is called Duplicate Chan Order From. 
This option allows you to duplicate the mixer channel order from the FOH or other Monitor 
Mixers.

* New options have been added to the Mixer Menu called Meter Tap Point Src, Pre-Fdr, and 
Pst-Fdr. These options allow you to set the tap point within the channel signal flow for the 
meter data. Selecting the Src option displays the meter data at the source position at the top 
of the module, after the attenuator, phase and mono sections. Selecting the Pre-Fdr option 
displays the meter data just before the mute switch and fader. Selecting the Pst-Fdr option 
displays the meter data at the end of the channel signal chain. These options can be saved 
with the preferences. 

* Added the hooks to SAWStudio Lite and Full (Version 4.2). The SAC Link option is 
activated from within the SAWStudio app and once a connection link between SAWStudio 
and SAC has been established, you can now pass data in both directions for recording and 
playback with SAWStudio using internal shared memory buffers that completely bypass the 
Windows soundcard drivers. SAWStudio will automatically disconnect from the drivers and 
use the internal shared buffers to communicate with the outside world through the SAC 
engine.



The menu options are selected from within SAWStudio and show up as follows:

The Activate SAC Link option on the SAWStudio Options menu will establish the internal 
connection between the two programs. SAC and SAWStudio must both be running at the 
time, and when the connection is established, a SAC<–>LINK icon will appear in the left 
corner of the SAWStudio main titlebar.

The SAC Link Options option expands out to include these following choices:

The Export Mix Data To SAC option allows you to instantly transfer the main MT track and 
channel mix data directly to the SAC FOH console. This will also automatically preset each 
SAC console channel input source to point to the associated SAWStudio MT track. This 
option allows you to playback the SAWStudio MT tracks in a 1 to 1 configuration through 
the SAC console. You can then use the SAC Monitor mixers to setup separate performer 
mixes. SAWStudio will not play audio through its own driver devices while the SAC Link is 
active. You do not have to make any preference changes in SAWStudio… the buffer settings 
will be internally set to relax the SAWStudio cpu load and rely on SAC to handle the low 
latency performance. The internal link will adjust for SAWStudio playback buffer size 
changing and latency causing plugins and deliver a fixed data stream to SAC with no 
changes needed to your edl session in SAWStudio.

The Import Mix Data From SAC option allows you to instantly transfer the SAC FOH 
console setup directly into SAWStudio, including automatically creating a record template 
with all channel input assignments preset, ready for a live recording of the current SAC 
session. All that is needed after this option is activated is to Ctrl-Click the first track’s record 
button in the SAWStudio MT to open all record meters for all active SAC channels, already 
pre-assigned. Once again, SAWStudio completely bypasses the soundcard drivers and 
gathers its audio data directly from the SAC engine. This allows SAWStudio to perform the 
MT record operation with very little added cpu load on the system, and also relaxes the 
buffer settings to essentially coast along quietly in the background while SAC handles the 
low latency monitoring load.

The Input Chan Play Tap At SRC option selects the SAWStudio tap for sending its track data 
to SAC. This option sends the data from the SRC position at the top of the chan module just 
after the Mono section. Using this option means you are essentially sending the playback 
data directly from the wav files on each track with no added processing from the SAWStudio 
virtual console.

The Input Chan Play Tap At PRE-PATCH option selects the SAWStudio tap for sending its 
track data to SAC. This option sends the data from just after the PRE-PATCH position within 
the chan module. This option would allow VST Synths data to be passed onto SAC and the 
Pre-Patch position routing options within SAWStudio will still apply, so some signal 
processing from SAWStudio may be part of the signal chain before the data reaches SAC.

The Input Chan Play Tap At PST-FDR option selects the SAWStudio tap for sending its 



track data to SAC. This option sends the data from the bottom of the chan module, which 
includes all chan processing and automation. Very useful for show playback of pre-recorded 
tracks.

Once the SAC Link is initiated, the SAC input source options will expand to allow individual 
SAWStudio Mixer Chan selections instead of just the hardware device selections. You will 
see all SAWStudio label references for each channel in the list. You may select any Input 
Chan from SAWStudio or any Output Chan. Selecting an Output Chan allows you to 
maintain a complete mix in the SAWStudio environment and only use one stereo input chan 
in SAC to playback the entire 72 tracks from SAWStudio. Any Input Chan selection is 
subject to the above mentioned Tap points set in SAWStudio.

Likewise in SAWStudio, the record meter Input Zone will display the SAC channel list with 
the SAC labels. You may record from any SAC channel which will automatically adjust the 
record meter to mono or stereo based on the SAC source assignment. An added bonus here is 
that you now have the ability to record extra channels in your current SAWStudio version 
than is possible with SAWStudio alone. For instance… SAWStudio Lite allows up to 24 
record meters which are normally connected to the 12 possible stereo hardware devices. 
Normally that translates to 12 stereo tracks or 24 mono tracks or any combination in 
between. But with SAC’s ability to handle 36 stereo devices, you would now have the ability 
to pass on up to 72 signals in any combination of mono/stereo to the 24 record meters. 
Therefore, you can now record up to 24 stereo tracks (48 channels worth of data) in Lite as 
long as you have that many channels of hardware devices connected to SAC.

Bug Fixes
* Fixed code to properly display and jump to the correct channel using the mixer popup jump 

menu when channels are re-ordered.

* Fixed crash that could occur when opening a mix session that has an input device assignment 
that is not available in the current preferences.

* Fixed crash that could occur due to meter routines overstepping their variable bounds when 
using multiple Monitor Mixers  under certain input and output assignment conditions.

* Closing a mix session now correctly clears all monitor settings and labels as well.

* Fixed the ASIO menu text display to properly display the 16 bit integer format.

* Fixed code to correct for meter timing drift on certain computers where the motherboard 
clock and soundcard driver clocks may exhibit pronounced timing differences.

>---<

Version Pre-Release 0.2a



Enhancements

Bug Fixes
* Fixed code to correct for issues with the M-Audio ASIO drivers and the new engine design. 

May also affect other ASIO drivers that may respond in the same manner.

>---<

Version Pre-Release 0.2
Enhancements
* Heavily re-designed the ASIO engine for higher performance and the ability to detect and 

correct for latency drift. This new design should completely correct for any slipped buffers 
that might occur, regardless of the cause of the slip. This should eliminate any possible 
latency drift once the engine is started.

* Removed the ASIO Skip First Buffer menu option since it is no longer needed with the new 
ASIO engine re-design.

* Heavily re-designed the MME engine for higher performance and the ability to detect and 
correct for latency drift. This new design should completely correct for any slipped buffers 
that might occur, regardless of the cause of the slip. This should eliminate any possible 
latency drift once the engine is started. Due to the extra complexity and kludge of the MME 
design protocol, you may find better stability in single CPU mode when using the MME 
driver model, although you may have better performance in dual cpu mode because the low 
level driver threads can be split off to the other processor keeping them separate from the 
mixer buffer processing threads.

* A new enhancement now allows you to check for slipped buffers by Left-Clicking in the 
Mixer Load Percentage readout display. A small message window will display the current 
count of input and output slipped buffers since the engine has been started. This slippage will 
have been automatically re-synced so there is no overall latency drift. If your system is 
running completely stable under load, these values should remain zero.

* Re-designed the engine code to now dynamically make use of all cpu’s in the system and 
maintain stability. Also re-designed the Force Single CPU option in the Options Menu to 
force the process itself to CPU 0 (first CPU), essentially the same as setting the process 
affinity in the task manager. This setting can be saved with the preferences to force SAC to 
CPU 0 every time it starts, if desired. When using buffer sizes of 64 samples or less, you may 
find higher stability and performance in single CPU mode on many multi-CPU systems. The 
processor and thread switching overhead can interfere in many cases with the extremely fast 
loop times required to maintain these low latency settings and actually start causing slipped 
buffers. Also note that drivers may still be spawning multiple threads to multiple CPU’s even 
with this setting active, and therefore total stability in a dual cpu system involves potentially 
hundreds or thousands of interwoven code segments throughout the entire system to be 



working in perfect sync. You may find much more stability by actually forcing the boot to 
only seeing a single CPU by using the boot.ini /ONECPU flag. Details are in my Windows 
XP Tweaks document on my website.

* Enhanced the Monitor mixer source assignments to allow taps from the FOH mixer or from 
the Monitor 1 mixer. This allows the Monitor 1 mixer to be used as a completely separate 
master monitor mixer with all other monitor mix taps coming from it. Monitor mixer 1 still 
taps from the FOH mixer, but the rest of the Monitor mixers can use the FOH taps or new 
taps labeled with the letter M at the end to tap from Monitor mixer 1. This allows complete 
separation of the Monitor mixers and FOH for use with two mixing engineers. FOH can use 
its own EQ and DYN and Monitor mixer 1 can act as a master Monitor mixer with a src split 
tap and its own EQ and DYN. The rest of the Monitor mixers can then tap from Monitor 
mixer 1 as a master, instead of FOH.

* Extended the Full Mixer Fader Jump zone to stretch from the bottom of the mute switch to 
the top of the meter, increasing the zone size making it easier to click and snap the Zoom 
Mixer display to the fader position.

* Removed the Ctrl-Solo switch option to be used for a new feature. You can still disengage all 
active solos by Left-Clicking the main Solo Light in the Main Window Top Client area.

* The Solo Light switch, in the main window top client area, has been enhanced to include a 
new feature. Left-Clicking on the solo light will now solo the current Mixer’s Master Out 
Channel 1. You can then adjust the mix while monitoring the master mix output without 
having to jump to the output chan to solo. Left-Clicking the solo light switch again, will 
disengage the special mode and all active solos. The original Hot Channel Solo Mode 
function has been replaced by this new function, but can still be activated by Alt-Left-
Clicking the Solo Light.

* The minimize routine has been modified to allow you to minimize the SAC program while 
the engine is live with much less chance of an audio glitch or slipped buffer on most systems.

* Added a new Midi Control Template for the Behringer BCF2000 unit. There is a sysex preset 
dump included in the SAC Configuration folder that must be sent down to the BCF2000 unit 
first and assigned to a preset. You can dump this file with any midi sysex dump utility 
program like Midi-Ox, or something similar.

The BCF2000 template gives you control of the 8 faders, in high resolution mode, as well as 
mutes, solos and pans. The top 2 buttons in the bottom right corner of the unit can be used to 
bank switch up or down, and the bottom 2 buttons of that group can be used to jump forward 
to the next console section (I, R, O).

Bug Fixes
* Fixed code to eliminate a random short blip sound when restarting the engine.



* Fixed code to properly initialize disabled channels when first opening a session file that has 
disabled channels in it.

* Fixed code to eliminate screen drawing problems that could cause screen corruption and 
display lockouts on multi CPU systems.

* Fixed code to allow the Hot Chan Solo Mode to chase mixers, so you can now switch to 
another mixer while the Hot Chan Solo Mode is engaged.

* Fixed code to allow Monitor Mixers to detect a VSTi Synth patched on a FOH channel 
without having to assign the FOH channel to an input source. Realize that a Monitor tap 
point of Pre or Pst Fdr is required to pickup a VSTi Synth patched in a FOH Pre Patch point, 
unless the Pre Patch point is re-routed to before the Eq and Dynamics, in which case a Pst Eq 
or Pst Dyn tap can also be used.

>---<

Version Pre-Release 0.1d
Enhancements
* Changed code to keep active Return channels processing blank buffers when there is no 

active data being sent so that patched plugins would keep any decaying data trails active.

* Added code to force an instant resync of the engine pointers by stopping and immediately re-
starting the engine. This is done by Shift-Left-Clicking the Live Light. If the engine slips 
buffers and starts loosing sync and adding latency, use this function. I am working on a way 
to do this with no audio dropout… we’ll see what happens.

Bug Fixes
* Fixed code to refresh the Midi Controller bank when switching between mixers.

* Fixed code to properly display the Dyn GR Meters on a remote station.

* Fixed code to properly display the Aux Master Meters on a remote station.

* Fixed code to stop crashes when adjusting the Compressor or Gate Threshold control on a 
remote station.

* Fixed code to properly display channel meters for the proper mixer selected on a remote 
station.

* Fixed code to properly reset live engine when engaging the Channel Disable switch from a 
remote station.



* Fixed code to correct for Monitor Return channel buffer pointer sync loss when using a FOH 
Return tap.

* Fixed code to properly rescan live engine pointer lists for all mixers when assignments are 
changed from any mixer and on any remote station.

>---<

Version Pre-Release 0.1c
Enhancements
* Enhanced VST Synth plugin windows to allow access to the midi options menu while the 

engine is live.

Bug Fixes
* Fixed code to properly handle the midi controllers and recompiled all new midi controller 

templates.

* Fixed code to chase the current physical channel when switching mixers.

* Fixed code to chase the current physical chan when opening the Wide Mixer View from the 
View menu.

* Fixed code to block VST plugins from toggling the engine with a right-click on the options 
icon.

* Fixed code to block engine toggle options in the Exploded Mixer View.

* Fixed code to clear all solos on all mixers when left-clicking the solo light.

>---<

Version Pre-Release 0.1b
Enhancements
* Added a new menu option to the popup Current Mixer menu (Right-Click in the Current 

Mixer Zone in the Main Top Client Area). The option is called Solo Master Out. This option 
gives you direct access to the current FOH or Monitor mixer Master Out solos, making it 
easy to solo a master mix while making adjustments.

* Added some default F-Key sets for some of the more popular screen resolutions.

Bug Fixes
* More work done on channel re-ordering in the Full Mixer and Zoom Mixer view. The popup 



Channel Selection Menu should now display and jump correctly to the proper channel no 
matter how the channels are re-ordered. The popup menu displays input channels in their re-
ordered condition, but Return and Output Channels will still be linearly displayed.

* Fixed Monitor Mixer Return Channels that use the Pre or Pst Fdr tap point from FOH to 
remain independent of each other.

* Fixed code to properly initialize VST Synth plugins into the engine loop with no channel 
input source assign needed. The VST Synth becomes the signal source for the channel.

* Fixed Name dialog for creating new scenes from displaying offscreen when close to the 
screen edge.

* Fixed menu checkmark for proper notice of the Max Screen Resolution Override option.

* Fixed code to fill screen resolution with default window if the software can not find an F-Key 
File of the exact Screen Resolution size.

* The Tab and Shift-Tab keys now correctly jump to the next and previous sections no matter 
how the channels are re-ordered.

* Fixed code that displays Channel groups by inversing the channel numbers. This will now 
correctly display when changing mixers. Also fixed the Right-Click group clearing 
function… it now correctly clears all channel selections on all mixers. Selected channels link 
only on the current mixer, not across all mixers.

>---<

Version Pre-Release 0.1a
Enhancements
* The Attenuator control has been enhanced to include +20db of gain as well as the 

attenuation.

* A new group of options have been added to the Current Mixer zone in the top Main Client 
Area. Right-Clicking in the Current Mixer zone will display a popup menu of options for 
duplicating sections of mixers to other mixers. The options are Duplicate Fdrs/Pans From, 
Duplicate Src-Ins From, Duplicate Eq From, and Duplicate Dynamics From. Each of these 
options will display another popup menu of choices for which mixer to duplicate from. To 
use the features, change to the mixer you wish to create a new mix on, and then select what 
you want to duplicate and then select the source mixer to duplicate from. This makes it easy 
to quickly setup a new Monitor mix by duplicating the faders and pans from the FOH or from 
any other Monitor mix, as well as duplicating input source settings and eq and dynamics.

* Scenes have been enhanced to allow for partial scenes which will overlay only selected 
channels on selected mixers and not disturb other mixers and channels when recalled. To 



create a partial scene, first select only the channels on whichever mixers you want to be 
altered when the scene is recalled, and then create the new scene or update an existing one. 
This is a very powerful new concept that can make recalling scenes in any order much more 
useful, because other current settings that have been altered since the scene was created will 
not be changed if those elements are not part of the partial scene as saved.

Bug Fixes
* Fixed VST .ini File Links. VST Plugs will now correctly load using the .ini File links.

* Fixed ASIO Driver code to correct for the use of odd size buffers (non powers of 2). This 
should also allow the use of 32 sample buffers if the driver permits it.

* Trapped Asio Driver Setup menu option when the engine is Live.

* The Wide Mixer Lock now correctly holds its channel even thru F-Key View changes.

* Fixed the Tab and Ctrl-Arrow key jumps to the next/prev mixer section to properly end up on 
the first I, R, or O chan regardless of mixer view screen size.

* Fixed the current Dwave Driver code to work with the Soundscape Mixtreme Dwave 
compatible driver.

* Fixed Channel Store / Recall functions to work correctly across mixers and selected 
channels.

* Fixed Solo In Place code from creating a loud buzz sound when activating the engine with no 
active routing just after a program start when Solo In Place is saved as the default Solo 
Mode.

* Fixed Dynamics GR Meter code to work properly and independent of each Monitor Mixer.

* Fixed Channel re-ordering to work correctly from the Full Mixer or Zoom Mixer view.

>---<

Version Pre-Release 0.1
Enhancements
First of the Pre-Release versions.

Quick Operation Info:
Setup your audio devices in the Audio Device Setup option of the Options Menu.

* To start the Live Mode engine Right-Click on the Live Lite at the top left corner of the Main 
window.



* Loading Mix Sessions or Mix Templates will force the engine off and flash the Live Lite 
when ready. You must then start the engine manually.

* You can save sessions, mix templates and scenes while the engine is live.

* The Tab key can be used in any mixer view to jump to the next mixer section (Inputs, 
Returns, Outputs) and will loop around to the start again. Shift-Tab jumps in reverse.

* You may use the PgUp and PgDn keys to jump up the Zoom Mixer module sections.

* You may use the Up and Dn Arrow keys to adjust the Fader ± .5db on the current Hot 
Channel. Pressing the Shift-Key also adjusts in ± 1db increments. Pressing the Control-Key 
also adjusts in ± .25db increments.

Bug Fixes

>---<
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